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1 Introduction

1.

Introduction

1.1

Add-on Module RF-FE-LTB

The module RF-FE-LTB is not a stand-alone program but is integrated in the RFEM environment as an add-on module. Thus, the model-specific input and loading data of all members is
automatically available in the post-processing program. Conversely, the results from RF-FE-LTB
can be graphically evaluated in the RFEM workspace and incorporated in the printout report.
RF-FE-LTB carries out the check against lateral buckling and lateral-torsional buckling according
to the finite elements method. The analysis is carried out on the entire structural system for notionally singled out sets of members. For this, the program determines the internal forces, deformations, and stresses of spatially stressed structural systems according to the second-order
analysis. Furthermore, RF-FE-LTB determines for a given load combination the stability load or
the maximum resistance load while observing the normal, shear, and equivalent stresses.
Separate design cases allow for a flexible analysis of lateral buckling and lateral-torsional buckling behavior.
According to DIN 18800, you can carry out the analysis according to various methods. RF-FE-LTB
provides the following approaches:
•

Calculation of the critical loads on a perfect system. This yields the
- Elastic flexural buckling load Ncr,z about the z-axis (out-of-plane),
- Elastic torsional buckling load Ncr,ϑ or
- Elastic critical moment for lateral-torsional buckling Mcr about the y-axis.

With these ideal values, you can carry out the stability analysis according to DIN 18800,
Part 2 for I-sections according to the equivalent member method (e. g. with RF-LTB).
•

Calculation of the ultimate capacity FT before a loss of stability occurs not exceeding the
predefined elastic limit stress (FT ≤ FG) or determination of the elastic limit load FG, under
which the elastic limit stress is reached (FG ≤ FT). The calculations are carried out on an
imperfect system.

•

Stress analysis with the internal forces calculated under i times the loads according to
second-order analysis (imperfect system with loads Fd)

The calculation is carried out according to the lateral-torsional second-order analysis with the
following possibilities:
•

Analysis on entire system to take into account, for example, the restraining effects for
structural components susceptible to LTB in a way that is appropriate for the system.

•

Determination of imperfections by an eigenvalue analysis prior to the calculation and
application of the scaled eigenvector as system initial deformation

•

Consideration of the influence of bracings and other supporting structural components
by placing eccentric nodal spring as well as idealization of warping restraints by means
of according single springs

•

Consideration of the elastic rotational restraint by trapezoidal sheeting (corrugated
sheeting) of the roof membrane and/or bracing shear stiffnesses in the form of distributed springs and rotational springs acting in both axes directions of the cross-section

•

Realization of a possibly existing restrained axis of rotation by specifying appropriate
boundary conditions

We hope you will enjoy working with RF-FE-LTB.
Your DLUBAL Team
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1.2
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1 Introduction

1.3

Using the Manual

Topics like installation, graphical user interface, results evaluation, and printout are described
in detail in the manual of RFEM. The present manual focuses on special features of the add-on
module RF-FE-LTB.
The description of the module follows the sequence and structure of the module's input and
results window. The text of the manual shows the described buttons in square brackets, for
example [View mode]. At the same time, they are shown on the left margin. In addition, expressions that are used in dialog boxes, tables, and menus are set in italics to clarify the explanations.
The index at the end of the manual helps you find specific terms and subjects. However, if you
still cannot find what you are looking for, please check our website www.dlubal.com where you
can go through our FAQ pages by selecting particular criteria.

1.4

Open the RF-FE-LTB Module

RFEM provides you the following ways to open the RF-FE-LTB add-on module.

Menu
You can open the add-on module by using the RFEM menu:
Add-on Modules → Design - Steel → RF-FE-LTB.

Figure 1.1: Menu: Add-on Module → Design - Steel → RF-FE-LTB

Program RF-FE-LTB © 2013 Dlubal Software GmbH
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Navigator
Alternatively, you can open the module in the Data navigator by double-clicking the entry
Add-on Modules → RF-FE-LTB.

Figure 1.2: Data navigator: Add-on Modules → RF-FE-LTB

Panel
If results from RF-FE-LTB are already available in the RFEM model, you can also open the add-on
module in the panel:
Select the relevant RF-FE-LTB design case in the load case list located in the menu bar. Then,
click [Results on/off] to graphically display the design criterion on the members.
On the panel, you can click [RF-FE-LTB] to return to the module.

Figure 1.3: Panel button [RF-FE-LTB]
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2.

Theoretical Background

This chapter provides the theoretical background that is important for working with RF-FE-LTB.
Basically, we introduce the theoretical approaches described in the literature. However, this introductory chapter cannot replace a textbook.

2.1

Preliminary Notes

2.1.1

General

Lateral-torsional buckling represents a stability case in which a primary flexural deformation is
superimposed with a lateral displacement including torsion. Lateral-torsional buckling and
flexural-torsional buckling are closely related terms. The difference is that lateral-torsion buckling is commonly associated with a stress from eccentric compression force, whereas flexuraltorsional buckling is induced by bending. Furthermore, there is the case of compression bending. In all cases, the position of the line of action of the loads applied to a member has a considerable influence on the magnitude of the stability load.
All mentioned stability problems can be analyzed in RF-FE-LTB. You can use different methods
to calculate the lateral-torsional buckling of beams. Here are some of them:
•

Equivalent member method according to DIN 18800, Part 1 and 2 (program RF-LTB [10])

•

Calculation of eigenvalues (Mcr, Ncr) for continuous members or any frameworks subjected
to three-dimensional stress (program RF-FE-LTB)

•

Limit load or stability calculation of frameworks subjected to three-dimensional stress according to second-order analysis on an imperfect system (program RF-FE-LTB)

•

Limit load or stability calculation of frameworks subjected to three-dimensional stress according to a geometrically exact theory on the imperfect system

The equivalent member method is sufficiently accurate for many practical construction purposes. This method is described and verified in DIN 18800, Part 1 [7] and 2 [8] and many other
publications. The method is implemented, for example, in the add-on module RF-LTB [10],
where the lateral-torsional buckling analysis is carried out for members with monosymmetrical
or doubly symmetrical I-section subject to uniaxial or biaxial bending and constant axial force.
The equivalent member method according to DIN 18800 is limited in its application to particular cross-sections (see above). In addition to this, you have to define boundary conditions for
the equivalent member, which is not easy for general framework systems and therefore can
only be estimated. For a more precise calculation, the framework subjected to three-dimensional stresses is to be computed by second-order analysis. Usually, this has to do with the
calculation of the elastic stability load of a single-span or multi-span beam of a frame.
The add-on module RF-FE-LTB is based on the finite element method and can be used to calculate the stability loads of members. Here, the elastic material behavior is assumed for a geometric nonlinear behavior. The following basic assumptions apply for the warping torsional
theory:
1. Shape-constant cross-sections to exclude local instabilities
2. Bernoulli bending
3. Moderate displacements or rotations that are small overall compared to the system
dimensions
The calculations are three-dimensional according to the second-order analysis for flexuraltorsional buckling, where the individual member elements are regarded as straight.
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In the analysis, initial deformations can be taken as scaled eigenvectors of the system. Furthermore, it is also possible to calculate eccentrically acting loads (for example load on top or bottom flange).
Depending on the geometric shape of the structural system, the actions, and the initial deformations (imperfections), different maximum failure and/or ultimate limit states can occur.
Figure 2.1 presents the basic structural responses.

F
F/2

F/2

f

Fki
FV
FG

FT

Fd
f
Figure 2.1: Structural responses

RF-FE-LTB gives the following results, as appropriate (see also Figure 2.1):
1. Critical load (bifurcation load) Fcr
•

Elastic critical moment for lateral-torsional buckling Mcr,y

•

Elastic flexural buckling load Ncr,z

•

Elastic torsional buckling load Ncr,ϑ

The program calculates always the smallest critical load of the system without considering initial deformations. The elastic critical loads are required in the application of the
equivalent member method (see chapter 2.6.1, page 33).
2. Ultimate capacity FT due to loss of stability (limit load) observing the elastic limit stress on
the imperfect system
The limit load FT is determined assuming a pure elastic material behavior with limitation
by an elastic limit stress to be defined.
3. Elastic limit load FG on imperfect system
This is a load that can be resisted by the system without that in any cross-section part the
normal stress, the shear stress, or the equivalent stress (according to VON MISES) is greater
than the respective limit stress. The calculation is to be carried out only in case of specified initial deformations.
4. Possible limit load Fv due to loss of stability for specification of initial deformations without observing the elastic limit stresses
5. Verification of the limit stresses under design loads Fd on the imperfect system according
to second-order analysis
Based on the second-order analysis, RF-FE-LTB can thus automatically find the critical, snapthrough, or elastic limit loads. These loads are determined iteratively.
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To determine the limit load FT or the elastic limit load FG (see Figure 2.1), an initial deformation
is to be applied to the system. In RF-FE-LTB, it is automatically generated from the first, lowest
eigenmode (eigenvector), as this buckling mode corresponds to the lowest stability load. The
scaling of this eigenmode is carried out according to DIN 18800 Part 2; however, it can also be
user-defined (see chapter 2.6.2, page 37 and chapter 3.8.3, page 75).

Section types

RF-FE-LTB carries out analyses for all rolled sections, monosymmetrical and doubly symmetrical I-sections, channels, T-sections, L-sections, rectangular sections, C-sections, hollow- and
annular sections, as well as built-up cross-sections. Here, the stresses are determined according to the second-order analysis at the governing cross-section points. The determination of
the elastic limit load FG (see point 3 above) or the limit stress analysis (see point 5 above) is
based on these stress calculations.
Moreover, you can also analyze any cross-sections (for example SHAPE-THIN sections). They
are directly imported from RFEM. Then, the stress analyses are run in the RF-FE-LTB module.
Springs can be defined in RF-FE-LTB as single springs or continuous springs with an arbitrary
point of application in the cross-section. As a rule, this is required when the stiffening effect of
the roof cladding (for example trapezoidal sheeting) is to be taken into account.
Concentrated loads and line loads can act at arbitrary locations in the cross-section.

2.1.2

Basis of the Calculation Method

The theoretical basis of the program RF-FE-LTB is very extensive and cannot be discussed here
in detail. The according background can be found, for example, in PETERSEN [2] or in RAMM,
HOFMANN [11].
Usually, there are no analytical solutions for flexural-torsional problems that include nonlinear
deformational dependencies. Therefore, the method of finite elements (FEM) is used in order
to determine approximate solutions for the differential equations given in [2] or [11]. The precision of the solution is dependent on the selected number of finite elements (see chapter 9.2).
For the FE discretization, elements with two nodes are used. Cubic Hermite polynomials are
applied within the elements for displacements in y- or z-direction and for the torsion about the
x-axis. The longitudinal displacement in x-direction is described by an application of a linear
polynomial. These applications solve the homogeneous differential equation of the corresponding linear analysis precisely, but are approximations for the second-order theory. The
practical application of the method showed that usually eight elements per span of a beam are
sufficient to calculate deformations with deviations of less than 5% from the convergent solution. A solution is called convergent if there are no more changes in the solution in case of a
doubled number of elements (see example 9.2, page 109).
Thus, we obtain a total of seven degrees of freedom per element node: ux, vy, wz, ϕx, ϕy, ϕz, ϕ‘x.
Where ux is the longitudinal displacement in the member direction; vy or wz is the displacement
in y- or z-direction, respectively; ϕx, ϕy, ϕz is the torsion about the x-, y-, or z-axis, respectively;
and ϕ‘x is the warping.
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2.1.3

Determination of the Initial Deformation

The initial deformation is computed by solving the eigenvalue problem:

(K − λ ⋅ I) ⋅ Φ = 0
Equation 2.1: Eigenvalue analysis

In Equation 2.1, the stiffness matrix K is a function of the axial forces and moments of the basic
load state. I is the unit matrix.
By solving the eigenvalue problems by an iterative method, we obtain the eigenvector Φ belonging to the lowest eigenvalue; this eigenvector then determines the shape of the initial
deformation. The scaling of the initial deformation is according to DIN 18800 Part 2.

2.1.4

Calculation According to Second-Order Analysis

For the second-order analysis, the following preconditions and assumptions are made:
•

The cross-sections are thin-walled and constant within each portion.

•

The individual member elements are regarded as straight.

•

The shape of the cross-section shall remain unchanged in the deformation of the member. Thus, we exclude local instabilities, which possibly are also to be prevented by the
stiffening of cross-sections.

•

For bending, the BERNOULLI hypothesis applies stating that the cross-section remains
plane.

•

The displacements and torsions are small compared to the dimensions of the system.

The internal forces computed by second-order analysis are relative to the displaced and rotated coordinate system and therefore do not need to be transformed for the stress analysis.
The analysis for a flexural-torsional problem can be carried out in different ways in RF-FE-LTB.
The ways are the following:
1. Determination of the critical load factor on the undeformed system
2. Determination of the critical load factor on the deformed system
3. Analysis of the stresses under design load
4. Calculation of the maximum resisting load not exceeding the stresses
Basically, the calculation is iterative, with the stiffness matrix K changing due to the already
computed internal forces and deformations. For the analyses according to the points 2, 3, and
4 described above, the eigenmodes are determined with the internal forces from the first step
and considered according to chapter 2.6.2 before the actual iterative calculation.
The determination of the critical load factor according to point 1 or 2 gives the stability load of
the analyzed structural system. In a numeric calculation, this load is characterized by the fact
that either the determinant of the matrix K becomes zero, or that very high displacements occur for very small load increases in the calculation. In both cases, the module RF-FE-LTB determines that the corresponding state of equilibrium is no longer stable.
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In the actual calculation, the program first computes the internal forces, deformations, and
stresses for the load increments specified by the user (see chapter 2.3 Stress Calculation). At
this point, there are two possibilities:
a) The load increments defined by the user are stable states of equilibrium. In this case,
RF-FE-LTB automatically increases the load exceeding the defined maximum load until
an instability occurs. The according value is then precisely determined by means of a
nested iteration.
b) The load increments defined by the user cannot be reached all. In this case, RF-FE-LTB
nests the load increment of the instability, starting from the last stable load increment.
Thus, the critical load factor is known that belongs to the critical load Fcr (lateral-torsional
buckling load). For point 1 (see above), we thus obtain the lateral-torsional buckling load belonging to the undeformed system. The maximum bending moment My thus corresponds to
the ideal lateral-torsional buckling moment. For point 2, we obtain the possible limit load FV
due to loss of stability. In both cases, the program does not check whether or not the limit
stresses are observed. The stresses can be found in the results windows, where exceeded
limits are highlighted.
The calculation of the system with initial deformation (see point 2 above) can also be carried
out in a way that the limit stresses defined by the user are observed. In this case, RF-FE-LTB
carries out the steps a) and b) and checks whether the limit stresses are observed.
Finally, it is also possible to carry out the second-order analysis on the system susceptible to
lateral-torsional buckling under the design load (see point 3 above). If RF-FE-LTB can find an
equilibrium in this case, then the design is directly verified if all limit stresses are observed.
For examples of the presented cases, see chapter 9.

2.2

Definitions

2.2.1

Coordinates and Displacements

Figure 2.2 shows the cross-section coordinates and the positive displacement values.

Figure 2.2: Cross-section coordinates and displacement values
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The longitudinal displacement uS is related to the centroid S. In contrast, the displacements vM
and wM as well as the rotations ϕxM, ϕyM, ϕzM, and the warping ϕ‘xM are relative to the shear center M. The displacements v, w, and u of an arbitrary cross-section point can be expressed with
the linearization common in the second-order analysis by means of the displacement values of
the shear center.

v = v M − (y − y M )(1− cos ϕ xM ) − (z − zM )sin ϕ xM ≈ v M − (z − zM )sin ϕ xM
w = w M − (z − zM )(1− cos ϕ xM ) + (y − y M )sin ϕ xM ≈ w M + (y − y M )sin ϕ xM
Equation 2.2: Displacement values

The displacement u of a point results from the translation of the cross-section in the x-direction,
the rotation about the y- and z-axis and from the warping due to torsion:
u = uS − w 'M z − v 'M y − ϕ'xM yo

with y0 Unit warping
Equation 2.3: Displacement values

2.2.2

Internal Forces

Figure 2.3 shows the used definitions of internal forces.

Mz
y

S
Vy

M

My
Mx

Vz

x
Mω

N

z
Figure 2.3: Definitions on internal forces at the positive cut face

The shear forces Vz and Vy as well as the torsional moment Mx and the warping moment My are
relative to the shear center M; the bending moments My and Mz as the axial force N are relative
to the centroid S.
The internal forces are always related to the principal axes of the cross-section. For unsymmetric cross-sections, we therefore assume the shear forces Vv and Vu and the bending moments
as Mu and Mv.
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2.2.3

Single Springs and Continuous Springs

Elastic supports can be modeled by considering centrically or eccentrically arranged single
springs or/and continuous springs (element springs).
Figure 2.4 shows the centric single springs on node K. These springs are related to the global
coordinate system (CSYS).

Figure 2.4: Centric nodal springs

The spring constants in Figure 2.4 mean:
CXK
CYK
CZK

Nodal spring constant in global X-direction in [kN/cm]
Nodal spring constant in global Y-direction in [kN/cm]
Nodal spring constant in global Z-direction in [kN/cm]

CϕXK

Nodal rotational spring constant about global X-axis in [kNcm]

CϕYK

Nodal rotational spring constant about global Y-axis in [kNcm]

CϕZK

Nodal rotational spring constant about global Z-axis in [kNcm]

CyK

Warp spring constant in [kNcm3]
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The eccentric nodal springs at node K are relative to the local coordinate system:

yS
y

S=K
CϕxK

M

x
zS

CyK

z
CzK

Figure 2.5: Eccentric nodal springs

x,y,z
CyK
CzK

Local coordinate system
Nodal spring constant in local y-direction in [kN/cm]
Nodal spring constant in local z-direction in [kN/cm]

CϕxK

Rotational spring constant about local x-axis in [kNcm]

CyK
yS
zS

Warp spring constant in [kNcm3] relative to the local x-axis (not shown in figure)
Distance of spring CzK from centroid S
Distance of spring CyK from centroid S

The continuous springs (element springs) are defined in Figure 2.6. These subgrade moduli
are relative to the local coordinate system and constant along the member. In the program,
they are related to the shear center M and recalculated.
cy

y

zS

S
x
cϕx

M y
S

z

cz

Figure 2.6: Continuous springs
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cy
cz

Nodal spring constant in local y-direction in [kN/cm]
Nodal spring constant in local z-direction in [kN/cm]

cϕx
yS
zS

Rotational spring constant about local x-axis in [kNcm]
Distance of spring cz from centroid S
Distance of spring cy from centroid S
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2.2.4

Loads

Figure 2.7 shows concentrated loads defined as centric nodal loads.

Figure 2.7: Centric concentrated loads

FX
FY
FZ
MX
MY
MZ

Concentrated load in global X-direction relative to M
Concentrated load in global Y-direction relative to M
Concentrated load in global Z-direction relative to M
Concentrated moment about global X-axis, relative to M
Concentrated moment about global Y-axis, relative to M
Concentrated moment about global Z-axis, relative to M

If the concentrated loads act centrically in the node K and point in the direction of the local
coordinates, we have the simple option to specify these loads locally as eccentric loads (Figure
2.8) by setting the according coordinates to zero.
Eccentric concentrated loads at node K are to be related to the local coordinate system.

y

S=K
M

zy

Fz

x

Fy
yz
z

Figure 2.8: Eccentric concentrated loads

Fy
Fz
zy
yz

Concentrated load in local y-direction
Concentrated load in local z-direction
Distance of load Fy from centroid in z-direction
Distance of load Fz from centroid in y-direction
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The following figure shows the definitions of the line loads.

Figure 2.9: Line loads

qx / qX
qy / qY
q z / qZ
yS
zS
m x / mX

Line load in local x- or global X-direction
Line load in local y- or global Y-direction
Line load in local z- or global Z-direction
Local y-coordinate (relative to S) of the line load qz
Local z-coordinate (relative to S) of the line loads qy
Local or global uniform torsional moment relative to S

The global line loads are automatically assumed to be acting in the shear center M, the local
line loads are to be specified relative to the centroid S.
The line loads can be specified globally as well as locally. Eccentric line loads can only be defined as locally related. For the specification, the loads are relative to the centroid S. Within the
program, they are converted to the shear center M.
The loads always relate to the main axes of the cross-section. For unsymmetric cross-sections,
the concentrated loads Fu and Fv and the line loads qv and qu are to be assumed.

18
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2.2.5

Boundary Conditions

The following figure shows the components of the displacement, torsion, and warping for
specifying the boundary conditions.

Figure 2.10: Boundary conditions

The restraints of the structural system by the support reactions (boundary conditions) must be
specified in the global direction, that is, they are related to the global axes X, Y, and Z. Thus,
the individual translational and rotational components are set to zero or set free by specifying
reference numbers.

2.3

Stress Calculation

RF-FE-LTB calculates the normal, shear, and VON MISES equivalent stresses at the governing
stress points i of the cross-section. All rolled, built-up, and parametric thin-walled crosssections of the library are permitted.
In the following equations, the stress points of the cross-section are indicated by the coordinates (yi, zi). All stresses are determined from internal forces that are calculated by secondorder analysis taking into account the partial safety factors for the actions.
The governing point for the determination of the stresses are dependent on the cross-sectional shape. In Figure 6.4 on page 92, they are shown for an exemplary cross-section. In the crosssection graphic, you can identify the stress point numbers listed in the output tables.
The bending moment My is positive if tensile stresses occur on the positive member side (in direction of the z-axis). Mz is positive if compressive stresses occur on the positive member side
(in direction of the y-axis). The sign definition for torsional moments, axial forces and shear
forces conforms to the usual conventions: These internal forces are positive if they act in a positive direction.
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With the consideration of the warping torsion, for the normal stresses σx not only components
from axial force and bending, but also from the warping torsional moment occur. We obtain
the following normal stress in a point i of the cross-section:
σ x ,i =

My
M
Mz
N
+
−
− y yM ( y i , z i )
A S y ( y i , z i ) S z ( y i , z i ) Iy

Equation 2.4: Normal stress σx

The symbols mean:
Symbol

Description

N

Axial force

My

Bending moment about y-axis

Mz

Bending moment about z-axis

My

Warping torsional moment

A

Cross-sectional area

Sy(yi,zi)

Section modulus about y-axis for point (yi,zi)

Sz(yi,zi)

Section modulus about z-axis for point (yi,zi)

Iy

Warping constant

yM

Main warping at point (yi,zi)

Table 2.1: Parameter for normal stresses σx

The shear stresses are composed of shear force and torsional parts. The primary shear stresses
τp in a point i of the cross-section are determined as follows:

τpi =

Vy ⋅ Q z ( y i , zi )
Iz ⋅ t( y i , zi )

+

Vz ⋅ Q y ( y i , zi )
Iy ⋅ s( yi , zi )

+

M x ,p
WT ( yi , zi )

Equation 2.5: Primary shear stresses τp

The symbols mean:
Symbol

Description

Vy

Shear force in direction of the y-axis

Vz

Shear force in direction of the z-axis

Mx,p

Primary torsional moment

Iy

Second moment of area relative to y-axis

Iz

Second moment of area relative to z-axis

Qy(yi,zi)

Statical moment relative to y-axis for point (yi,zi)

Qz(yi,zi)

Statical moment relative to z-axis for point (yi,zi)

t(yi,zi)

Thickness of the governing cross-section parts in point (yi,zi)

s(yi,zi)

Thickness of the governing cross-section parts in point (yi,zi)

WT(yi,zi)

Torsional section modulus for point (yi,zi)

Table 2.2: Parameters for primary shear stresses τp
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Furthermore, it is possible to calculate the secondary shear stress τs due to the secondary torsional moment Mx,s.

τs i =

M x ,s ⋅ A y (y i , zi )
Iy ⋅ t(y i , zi )

Equation 2.6: Secondary shear stress τs

The symbols mean:
Symbol

Description

Mx,s

Secondary torsional moment

Ay(yi,zi)

Warping area in point (yi,zi)

Iy

Warping constant

t(yi,zi)

Thickness of the governing cross-section parts in point (yi,zi)

Table 2.3: Parameter for secondary shear stresses τs

The calculation of the secondary shear stresses is possible for rolled cross-sections, monosymmetrical and doubly symmetrical I-sections, and box sections.
In RF-FE-LTB, it is up to you to decide whether or not the secondary shear stresses are to be
taken into account in the stress calculation. If they are to be included in the stress calculation,
they are directly added to the primary shear stresses.
The Equivalent stress σeqv according to VON MISES is determined from the normal and shear
stress as follows:
σ eqvi = σ 2x + 3 vp2 ,s i
Equation 2.7: Equivalent stress σeqv

In the standard case, it is assumed for the calculation of the equivalent stresses that the secondary shear stresses may be neglected. However, if they are considered (see above), the sum
from primary and secondary shear stress is taken for τp,s. The shear stresses due to primary torsional moment according to Equation 2.5 are always considered in Equation 2.7.
The normal, shear, and equivalent stresses are calculated for all points in the cross-section that
can be governing for the three-dimensional stress resulting in lateral-torsional buckling. In the
output, the location where the maximum value occurs for every type of stress (normal, shear,
and equivalent stress) is shown.
In the limit load calculation, the limit load FG is calculated for which at no location in the crosssection the allowable values for the stresses due to i times the actions are exceeded. To this
end, it is necessary to determine the maximum stress in the cross-section. Thus, the following
conditions are to be satisfied:

max(σx i ) ≤
i

fy ,k
iM

;

max( vp ,s i ) ≤
i

fy ,k
iM , 3

;

max(σeqv i ) ≤
i

fy ,k
iM

Equation 2.8: Conditions for the limit load FG

If the design is carried out according to DIN 18800 Part 2, element (121) and Part 1, element
(749), then the normal or equivalent stresses may exceed these limit values by 10 % (see
chapter 2.6.1).
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2.4

Determination of Restrained Axis of Rotation

In practical constructions, there is often a constructively caused lateral-torsional problem with
restrained axis of rotation (translational restraint) at a distance zD of the centroid. This restrained
rotational axis is implemented as continuous or discrete translational springs in y-direction. For
the spring stiffnesses, values of the magnitude 108 through 1010 for cy are to be taken to suppress the displacements in the restrained axis of rotation.

Figure 2.11: Torsional restraint

The translational restraint may be taken according to DIN 18800 Part 2 [8] in the design of a
sufficient lateral restraint of deformation. To achieve a sufficient restraint, you can, for example, use masonry permanently connecting to the compression flange. If trapezoidal sheets
according to DIN 18807 [13] are connected to the girder and the condition
prov S ≥ req S
Equation 2.9: Condition for shear panel stiffness

where


 70
r2
r2
req S = Sa =  E Iω 2 + G IT + E Iz 2 hp2  2


4L
L

 hp
Equation 2.10: Required shear panel stiffness for attachment in every groove

for an attachment in every groove (rib) is satisfied, then the point of connection must be seen
as rigidly fixed in the plane of the trapezoidal sheeting.
Sa refers to the portion of the shear strength of the trapezoidal sheeting for the analyzed beam
according to DIN 18800 Part 1 [7] in case of attachment in every rib. Here, L is the span width of
the beam to be braced and hp is the depth of the beam (provided that it is an I-section).
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If the trapezoidal sheeting is fastened only in each second rib, then the following applies:

req S = Sb = 5 ⋅ Sa
Where

Sa

see Equation 2.10

Equation 2.11: Required shear panel strength for fixation in every second groove

Equation 2.10 and Equation 2.11 for the determination of the lateral restraint of a beam (translational restraint) can, in case of an according type of the points of connection, used for other
sheeting than trapezoidal sheeting, see note on DIN 18800 Part 2, element (308).
The ideal shear modulus of a trapezoidal sheet is given as:

Gs =

10 4
K
K 1 + 100 2
Ls
where

 kN 
m
 

K1

Shear panel value according to approval in [m/kN]

K2

Shear panel value according to approval in [m2/kN]

LS

Shear panel length in [cm], see Figure 2.12

Equation 2.12: Shear modulus of trapezoidal sheeting

Thus, it follows for the shear stiffness part of the beam to be braced (for example frame beam
in Figure 2.12):

ST =

a
Gs
100
where

[kN]
a

Distance of the beam to be braced (frame beam) in [cm]

Equation 2.13: Shear stiffness of trapezoidal sheeting

Figure 2.12: Frame beam with trapezoidal sheeting and bracings
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The shear strength of the wind bracings and stabilizing bracings can also be considered. For
the ideal shear stiffness of one bracing with connections without slip, we obtain (see [8] and
[1]):

SV =

1
1
1
+
2
E
⋅
A
E ⋅ AD ⋅ sin α ⋅ αos α
P ⋅ αot α

where

SV

Shear stiffness of bracing in [kN]

AD

Area of the diagonal in [cm]

AP

Area of posts in [cm]

α

Angle between diagonal and frame beam flange

Equation 2.14: Shear stiffness of bracing

In the equation above, only the tension diagonals of the cross bracing are considered. If different posts or diagonals are intended, the minimum cross-section areas are to be taken for AP or
AD .
Equation 2.14 can be converted as follows.

SV =

a2 b E
3

 a2 + b 2 


3

 +a
AD
AP

Equation 2.15: Shear stiffness of bracing

Thus, it is possible to approximately calculate the shear stiffness for one frame beam or girder
(only from bracings).

SR = m

a
SV
Ls

where

m

Number of stiffening bracings in roof plane

Equation 2.16: Shear modulus of trapezoidal sheeting

If the shear stiffnesses from trapezoidal sheeting and bracing are applied at the same time,
we obtain from Equation 2.10, Equation 2.14, Equation 2.15, and Equation 2.13:
•

Connection in every groove:

prov S = S T + SR
Equation 2.17: Shear panel stiffness

•

Connection in every second groove

1
prov S = S T + SR
5
Equation 2.18: Shear panel stiffness

The analysis is then run according to Equation 2.9.
In RF-FE-LTB, a continuous translational restraint is to be accordingly idealized by continuous
lateral translational springs cy with a high stiffness, for example 106 (kN/cm)/cm. An example
for this can be found in chapter 9.9, page 117.
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Laterally adjacent members that are fixed in the longitudinal direction (for example single
purlins resting on the frame beam) can be idealized by discrete single springs cy in those
points, for example as follows:

cy =

E⋅A
L

where

L

Length of purlin up to the support point

E

Modulus of elasticity

A

Cross-sectional area of purlins

Equation 2.19: Translational spring by single support

If the check of a translational restraint according to DIN 18800 Part 2 is not fulfilled, it is possible
to determine a continuous translational spring by means of the determined ideal shear stiffness
prov S (see chapter 2.5.2).

2.5

Determination of Spring Stiffnesses

2.5.1

Rotational Springs

The calculation of the provided rotational restraint coefficient is based on the model of several
springs placed one behind the other (see [8], [14]).

1
1
1
1
=
+
+
prov cϑ,k cϑM,k cϑA ,k cϑP ,k
Equation 2.20: Effective rotational restraint

For simplification, Equation 2.20 in DIN 18800 is expressed with the characteristic values. The
symbols of this equation are described in the following.

Rotational restraint cϑM,k from supporting structural component
c ϑM,k =

E ⋅ Ia
⋅k
a

Equation 2.21: Rotational restraint from supporting structural component

The value cϑM,k represents the theoretical rotational restraint from bending stiffness Ia of the
supporting structural component a assuming a rigid connection. Furthermore, the following is
valid for Equation 2.21:
Ia

Moment of inertia of the supporting structural component in [cm4/cm]

A

Span of the supporting structural component in [cm]

K

Coefficient:

k=2

for single-span and double-span beams, end-span beams

k=4

for continuous beam with three or more spans

For a noncontinuous rotational restraint (for example by purlins), the moment of inertia Ia of the
supporting structural component is converted to a continuous support according to Ia = I / e,
where e is the distance of the supporting single-span beams (for example purlins).
If the supported beam can rotate only in one direction, the cϑM,k value may be multiplied by
factor 3.0 according to Equation 2.21. This is the case if, for example, a supported beam is part
of the structure of an inclined roof.
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Rotational restraint cϑA,k from deformation of the connection
cϑA,k represents the rotational restraint from deformation of the connection. For connections of
single girders by means of bolts without slip (alternatively left and right from web of the crosssection to be stiffened), we can assume a rigid connection as approximation, that is, cϑA,k is
equal to infinity and is discarded in Equation 2.20.
For rotationally elastic support by means of trapezoidal sheeting, we obtain:
2

b
b 
cϑA ,k = cϑA ,k  1 
for 1 ≤ 1.25
10
 10 
b
b 
cϑA ,k = 1.25 cϑA ,k  1  for 1.25 < 1 ≤ 2.0
10
 10 
Width b1

Width of the top flange of the supported beam in [cm]

Equation 2.22: Rotational restraint from deformation of the connection

The characteristic value for the joint stiffness c ϑA,k of steel trapezoidal sheeting profiles is taken
from Table 7 of DIN 18 800 Part 2. This table is included in the program.
If ratio b1/10 > 2.0, the ratio in the equation above is limited to 2.0 in order to be on the safe
side. According to OSTERRIEDER [8] (note in paragraph 4), is also possible to specify values for
c ϑA,k that are greater than those given by Table 7 . This option is also available in the program.
If the coefficient c ϑA,k is determined according to Table 7 and the trapezoidal sheeting profiles
show thicknesses t greater than 0.75 mm, we obtain greater joint stiffnesses. Approximately,
the table value may be increased by a factor as follows [15]:

 tprov 


 0 ,75 

2

tprov in [mm]

Equation 2.23: Increase factor for thicknesses > 0.75

Rotational restraint cϑP,k from cross-section deformation
cϑP,k is the torsional restraint due to deformation of the supported beam section. It is obtained
as follows [15].

cϑP ,k =

E

1
h
4 ⋅ (1− µ ) m + 0.5 ⋅ b1
s3
t13
2

Where b1, t1

⋅

Width or thickness of the top flange of the supported beam in [cm]

S

Web thickness of the supported beam in [cm]

hm

Distance of the flange's centerline in [cm]

µ

Poisson's ratio of steel with the fixed value µ = 0.3

Equation 2.24: Rotational restraint from distortional buckling

The determination of cϑP,k according to Equation 2.24 in [15] necessarily requires that in the
case of a noncontinuous rotational restraint, the concentrated loads from the supported structural component (transferred to the supported beam) reach only a maximum of 50 % of the
limit loads for constructions without stiffeners (see for example [7]). Further values can be
found in the manual RF-LTB [10] and in the commentary [15], page 169.
The continuous rotational springs according to Equation 2.20 (cϑ,k = cϑ,x) can be used as discrete rotational spring (single spring) if the continuous spring is multiplied by the corresponding influence width.
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2.5.2

Translational Springs

For the frequent case of a beam span (for example frame beam, platform beam, or floor beam)
stabilized by one or several bracings, the translational springs can be determined cy according
to PETERSEN [2] as follows:

c y = pπov S ⋅

π2
2

L

where prov S
L

 kN / m 
 m 


Part of the shear stiffness of a beam according to Equation 2.17 or
Equation 2.18
Length of bracing

Equation 2.25: Translational spring constant

Figure 2.13: Frame beam with trapezoidal sheeting and bracings

The bracing should have a regular structure, because the equation for cy is derived by a "uniform smearing" of the bracing over the length L.
The shear stiffnesses from bracing and trapezoidal sheeting may be added only if the beams
that are to be restrained by laterally connected sections resistant to compression and the
trapezoidal sheets above are connected to the bracing:
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Trapezoidal
sheeting

Compression
connection to
bracing

Figure 2.14: Stiffening by trapezoidal sheeting and compression sections

Thus, the trapezoidal sheeting and the bracing act as parallely placed springs that can be added up to a global spring. If the beams are connected only by supporting purlins with each other (which, conversely, are possibly supported by trapezoidal sheeting), then only the part SR
(see Equation 2.16) from the bracing is taken for prov S.
An example for the determination of a lateral translational spring cx is given in PETERSEN [2]
chapter 7.17.3. In [2] and in the Stahlbau Handbuch [17], chapter 3.2, you can find further
information for the determination of equivalent stiffnesses.
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2.5.3

Warp Springs

The restraint of the warping increases the torsional stiffness of a girder with a thin-walled open
cross-section. This increase can be considered by discrete warp springs Cy.

Warping restrained by an end plate [4], [10]
In this case, the warp spring is given according to Equation 2.29 as follows:

1
Cω = ⋅ G ⋅ b ⋅ h ⋅ t3
3
Equation 2.26: Warp spring by end plate

Figure 2.15: Warp spring from end plate

Warping restraint by a cantilevered portion [2]
The warp spring due to a cantilevered portion is determined acc. to the following equation:

Cω = G ⋅ IT ⋅

1
⋅ tanh (n ⋅ L k )
n

λ=

where

G ⋅ IT
E ⋅ Iω

Length of cantilevered portion

Lk

Equation 2.27: Warp spring from cantilevered portion

x
y
z
w=0

lk

Figure 2.16: Warp spring from cantilevered portion
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Warping restraint by means of a diaphragm resistant to torsion
The warp springs from the end plates or cantilevered portions results only in a relatively small
restraint. The intended installation of cross-stiffenings resistant to torsion in the form of welded channel sections or angles is more effective[2]. This results in a closed box section about the
z-axis (vertical axis)

hm

t

bu

s

h

u

Figure 2.17: Warp spring from cross-stiffening

Cω = G ⋅h ⋅

2
4 (b u ⋅ t u )2
4 ⋅ Am
= G⋅h⋅
L
h 
b
2 u + u 
∑ ti
s 
i
 t

where Am

Area enclosed by the centerline

L

∑ ti

Sum of the side lengths divided by the respective plate thickness

i

Equation 2.28: Warp spring from cross-stiffening
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Warping restraint by a column connection
The warp spring Cy for the frame beam can be calculated according to the basic expression:

1
C ω = ⋅ G ⋅ b ⋅ hm ⋅ t 3
3
where G
IT

Shear modulus
Torsional moment of inertia for
•

closed sections:
Am

•

I T ,Bredt =

2
4 Am
L
∑ ti
i

area of the section enclosed by the centerline

5

t  
1
t
open sections: IT ,St . Ven. = ∑ Li ⋅ ti3 1+ 0.63 i + 0.052 i  
3
Li

 Li  


The expression in the brackets is a correction factor that takes into
account the solidness of individual rectangular components (length Li,
thickness ti). For thin-walled sections, this factor can be taken as 1.0.
hm

Distance of the flange centerlines

Equation 2.29: Warp spring from column joint

hm

Figure 2.18: Warp spring from column connection
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2.6

Analyses According to DIN 18800

The following chart shows the possible analyses that are supported by RF-FE-LTB and compliant with DIN 18800.

Figure 2.19: Analyses according to DIN 18800 with RF-FE-LTB
a) Plane second-order analysis
b) Spatial second-order Analysis

The calculation of the critical load factor on the global system according to the second-order
analysis or the check of the elastic limit stresses under (i times) design loads according to second-order analysis of the global structural system should always be preferred to the equivalent
member method, as the real boundary or transition conditions are considered on the global
structural system.
The ideal critical loads whose values are included in the equivalent member method can also
be determined in RF-FE-LTB for the global system (that is, more precise than by means of analytical expressions that consider the boundary and transition conditions only approximately),
but the critical loads can be qualified precisely (see example in chapter 2.6.1).
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2.6.1

Equivalent Member Method

For simplification according to DIN 18800 Part 2, the analyses for lateral buckling and lateraltorsional buckling are carried out separately. As a rule, the analysis of the lateral buckling (see
the following figure) is carried out in the plane of the structural system by calculating the
plane structure according to second-order analysis as stress analysis under the design loads
and by applying the initial deformations.

Figure 2.20: Analysis of a structure: flexural buckling in the plane and lateral-torsional buckling for an individual member

The analysis of the lateral-torsional buckling is performed on a notionally singled out individual member with the following boundary conditions and loads:
•

Loads
The individual member is loaded by the design loads and at the member ends by the internal forces determined on the global structural system.

•

Geometrical boundary conditions and elastic supports
The kinematic conditions that you can see when cutting out the individual member from
the global system are to be specified as boundary conditions, especially those regarding
the deflection perpendicular to the plane of the structural system and the torsional restraints. Elastic supports by adjacent structural components can be considered by means
of equivalent springs according to chapter 2.5.
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For an individual member defined in such a way, there are two possibilities for the lateraltorsional analysis (see also Figure 2.19):

2.6.1.1

Equivalent Member Analysis

The simplified analysis according to DIN 18800 Part 2, elements (306), (307), (311), (320), and
(323) is essentially limited to doubly symmetrical or monosymmetrical I-sections (see element
(311), note 1). In addition to this, this verification format can be used only for specific loads that
are based on the following ideal critical values:
Mcr,y

Elastic critical moment for lateral-torsional buckling according to elasticity theory for
the sole action of moments My without axial force

Ncr,z

Axial force under the smallest critical buckling load according to elastic theory (the
smallest load from buckling about the z-axis or lateral-torsional buckling about this
axis, or torsional buckling, see for example manual for program RF-LTB [9].

In RF-FE-LTB, you can calculate these ideal critical loads also on the undeformed individual
member (perfect system). The program always gives the smallest critical buckling load. In the
equivalent member method, however, the values Mcr,y and Ncr,z are used. Hence, it is necessary
to check whether the critical buckling load calculated by the program corresponds to these
values (see also example 9.9 on page 117, where Ncr,y is smaller than Ncr,ϑ).

Example
Nd = 700 kN
x

U 400, St 52
y

S

6m
z

Left support:

u = v = w = φx = 0

Right support:

v = w = φx = 0

Centric compression force:

Nd = 700 kN

Figure 2.21: Channel section with centric compression force

For lateral buckling, the following critical loads result:
Ncr ,z =

Ncr ,y =

E ⋅ Iz ⋅ r2
2

L

E ⋅ Iy ⋅ r2
2

L

=

=

21,000 ⋅ 20 ,350 r 2
800 2

21,000 ⋅ 846 r 2
800 2

= 6 ,590.3 kN

= 274.0 kN

Equation 2.30: Critical loads

The elastic torsional buckling load Ncr,ϑ according to [10] is determined according to the
following equation.
Ncr ,ϑ =

E ⋅ Iz ⋅ r2
λ2eqv ⋅ i2z

Equation 2.31: Elastic torsional buckling load
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To solve Equation 2.31, the equivalent slenderness λeqv is necessary.
2
2 
 L  c2 + iM

λ2eqv =   ⋅
⋅ 1+
2 
i
2
⋅
c

 z


4 ⋅ c2 ⋅ ip2 
2 2 

c2 + iM

2

2
2
4 ⋅10.54 2 ⋅15.212
 800  10.54 + 16.04 
=
⋅ 1+
 ⋅
2
2

2 ⋅10.54
 14.9 
10.54 2 + 16.04 2


(

)

(

)


 = 8939.5



⇒ λ eqv = 94.5
Equation 2.32: Equivalent slenderness

The slenderness values in Equation 2.32 are determined as follows:
ip = i2y + i2z = 14.92 + 3.04 2 = 15.21cm

zM = −5.11cm
2
iM = i2y + zM
= 15.212 + ( −5.11)2 = 16.04 cm

Equation 2.33: Slenderness values

c is the so-called twisting radius.

c2 =

Iω L2 G ⋅ IT 221,000 8002 8 ,100 ⋅ 81.6
+ ⋅
=
+ 2 ⋅
= 111.15 cm2
⋅
Iz π2 E ⋅ Iz
20 ,350
21
,
000
20350
π

⇒ c = 10.54 cm
Equation 2.34: Twisting radius

Thus, it is possible to compute the elastic torsional buckling load according to Equation 2.31.

Ncr ,ϑ =

21,000 ⋅ 20 ,350 ⋅ r 2
94.52 ⋅ 14.9 2

= 2,125.2 kN

Equation 2.35: Elastic torsional buckling load

Ncr,y is the lateral buckling load about the y-axis in the plane of the structural system, Ncr,z is the
lateral buckling load for buckling about the z-axis (that is, deflection in the direction of the yaxis). Ncr,ϑ represents the torsional buckling load: the cross-section in y-direction is displaced
and at the same time rotated about the longitudinal x-axis. Since Ncr,ϑ is smaller than Ncr,z, this
value is governing for the check of the equivalent member according to element (306) and
(304).
Buckling curve c →
λk =

α = 0.49

λk 94.5
=
= 1.017
λ a 92.9

[

]

k = 0.5 ⋅ 1+ 0.49 ⋅ (1.017 − 0.2) + 1.0172 = 1.217
κz =

1
1.217 + 1.2172 − 1.0172

= 0.530

Equation 2.36: Reduction factor
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Npl,d =

36
⋅ 91.5 = 2994.5 kN
1.1

Equation 2.37: Plastic axial force

Check:

Nd
700
=
= 0.44 ≤ 1.0
κ z ⋅ Npl,d 0.53 ⋅ 2994.5
Equation 2.38: Plastic axial force

Thus, the check against lateral-torsional buckling would be fulfilled, while the check for lateral
buckling about the y-axis would fail because Nd = 700 kN > Ncr,y = 274 kN.
The program RF-FE-LTB gives the smallest critical load factor Ncr,y = 274 kN. To determine the
governing critical load for deflection in y-direction, you might have to apply a mid-span support in z-direction (wx=l/2 = 0). The resulting values are shown in the following table:
Ncr

analytical

RF-FE-LTB wl/2 ≠ 0

273.8 kN

Ncr,y = 274.0 kN

RF-FE-LTB wl/2 = 0

2451.0 kN

Ncr,ϑ = 2125.2 kN

Table 2.4: Critical buckling loads

The ideal values Mcr,y (without axial force!) and Ncr,z or Ncr,ϑ (under the sole action of a centric
axial force) must be determined separately with RF-FE-LTB, that is, in two calculation runs at
the respective perfect system.
This example shows the problem of the equivalent member method. A better method is the
second possibility for the individual member presented in the following chapter.

2.6.1.2

Ultimate Limit State Analysis for Spatially Imperfect Individual Member

As an alternative design method, you can use the calculation of the spatially imperfect individual member according to second-order analysis of elasticity according to element (121)
together with element (201) in RF-FE-LTB.
In case of a stable equilibrium, the maximum equivalent stress must be smaller than the limit
stress fy,d. In small portions, the equivalent stress may exceed the limit stress fy,d by 10% (see
chapter 2.6.3, page 38). The imperfections are to be applied in compliance with DIN 18800
Part 2 (see the following chapter 2.6.2). Thus, the procedure corresponds to the elastic-elastic
method.
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2.6.2

Determination of Initial Deformations

According to DIN 18800 Part 2 for the second-order analysis for considering geometrical and
structural imperfections, geometrical equivalent imperfections are to be specified. For unbraced systems, these are usually initial sway imperfections caused by angles of bar rotation.
For braced systems, these are initial bow imperfections (initial camber) in the form of sinusoidal or parabolic half-waves.
The shape of the initial deformation should be taken affine to the lowest buckling or lateraltorsional buckling eigenmode, see element (202). According to the commentary to DIN 18800
[15], it is sufficient to select the initial deformation in such a way that a sufficiently great component of the lowest eigenmode is included. Thus, the program aims at ensuring that the
load-deformation-curve tends towards the first eigenvalue.
To this end, RF-FE-LTB calculates the eigenmode belonging to the smallest eigenvalue (preliminary eigenvalue analysis) and chooses it as deformation mode (imperfection shape). The deformation modes in the direction of the main axes y and z are analyzed and the deflection direction belonging to the smallest eigenvalue is chosen (initial deformation in y-direction vv, in
z-direction wv). Taking into account these initial deformations, bending moments result on the
uniformly loaded beam about both cross-section axes as well as torsional moments.
Next, the imperfection is considered by a user-defined scaling of the eigenmode. For this purpose, the following menu options are available in the program (see chapter 3.8.3, page 75):
•

Direct numerical specification of the maximum camber rise of the initial deformation by a
graphical representation of the eigenvector and the location of the maximum displacement.

•

Calculation of the camber rise (initial bow imperfection) according to element (204), Table
3 with the user-defined governing buckling curve and the reference length; furthermore,
the calculation of the initial sway imperfection according to element (205) considering the
reduction factors r1 and r2. In determining the initial sway imperfection, the user specifies
the required data (like reference length and number n of the mutually independent causes for the initial sway imperfections of members).

The initial deformations to be taken according to [3] chapter 2.2 and 2.3 may be reduced under
certain conditions. In RF-FE-LTB, you have the following options:
Reduction 1) according to element (201)
For the elastic-elastic method, camber rises of the bow imperfections or the initial sway imperfections ϕ0, which depend on the buckling curve, may be reduced by the factor 2/3.
Reduction 2) according to element (202)
In the lateral-torsional buckling analysis, the amplitudes of the initial bow imperfections out of
the principal stress plane may be reduced by another 50 %.
The reduction option 2) is not without its problems, as this reduction may be carried out only if
the initial deformation mode for the lateral-torsional buckling belongs to the smallest eigenmode. This effect is illustrated in the following Figure 2.22.
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qd

Nd

Nd

qd

v,y

Nd

Nd

v,y

qd

z,w
z,w
a) v-direction
governing

b) w-direction
governing

Figure 2.22: Governing initial deformation for the reduction according to DIN 18800 Part 2, element (202).

RF-FE-LTB analyzes both principal axes directions y and z. This is because depending on the
spatial arrangement of the member and the load constellation, either the w- or the v-direction
can be governing for the lateral-torsional buckling.
In case a), v corresponds to the direction of deflection for the lateral-torsional buckling. If the
lowest eigenmode belongs to this direction, a reduction by 50 % is allowed.
In case b), the displacement mode w can be imagined as the initial deformation mode in the
direction of v according to DIN 18800 Part 2. Thus, a reduction by 50 % may be carried out only
if the eigenmode of the lowest eigenvalue (which is to be scaled by the user) runs in the wdirection.
To learn more about the determination of the initial deformation, see chapter 3.8.3.

2.6.3

Second-Order Ultimate Limit State Analysis

RF-FE-LTB determines the internal forces according to the second-order analysis taking into
account spatial initial deformations (see chapter 2.6.2).
For the elastic-elastic method: according to DIN 18800 Part 2, element (121), it is necessary to
verify that under the design actions (iF times the loads) the following conditions are met

max σ x ≤ fy ,d ; max v ≤
max σ v ≤ fy ,d =

1
fy ,d
3

fy ,k
γM

Equation 2.39: Design conditions for stresses

According to DIN 18800 Part 1, element (749), the equivalent stress may exceed the limit stress
σeqv by 10 % in isolated points.
max σeqv ≤ 1.1 fy ,d
Equation 2.40: Allowable overstressing
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For members subjected to axial force and bending, an "isolated point" can be assumed if the
following is valid at the same time:

N My
+
z ≤ 0.8 fy ,d and
A Iy
N Mz
+
y ≤ 0.8 fy ,d
A Iz
Equation 2.41: Allowance for locally limited plastification

As a rule, the maximum stress occurs on a cross-section edge at which the shear stresses from
the shear forces become zero. Thus, the analyses are reduced to the analysis of the normal
stresses.

2.6.4

Limit Loads FT or FG

RF-FE-LTB also offers the option to carry out the ultimate limit state analysis by comparing the
limit loads (ultimate capacity) with the design loads Fd. Only the following analysis is of practical importance:

FT ≥ Fd or FG ≥ Fd
Equation 2.42: Design conditions for ultimate loads

The program determines the load level FT or FG by an iterative load increase (see Figure 2.1,
page 10).
FT

Ultimate capacity due to loss of stability (limit load) on the imperfect system not exceeding the elastic limit stress

FG

Elastic Limit Load on imperfect system (all shear, normal, and equivalent stresses are
less or equal to the respective elastic limit stress)

RF-FE-LTB additionally allows you to calculate the limit load FV due to initial deformations
without observing the elastic limit stress. This ultimate load, however, is only of theoretical
interest.
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3.

Input Data

After you start the add-on module, a new window appears. The navigator on the left shows the
available module windows. Above the navigator, you find a drop-down list with the design
cases (see chapter 8.1, page 102).
You must define the design-relevant data in several input windows. When you open RF-FE-LTB
for the first time, the following RFEM data is imported:
• Sets of members
• Load cases and load combinations
• Materials
• Cross-sections
The sets of members are considered as notionally singled out from the model, that is, they are
not coupled to the members in the RFEM model. Changes of cross-sections and the geometry
are automatically compared with RF-FE-LTB. Imperfections from RFEM are not imported.
To go to a particular module window, click the according entry in the navigator. To go to the
previous or next module window, use the buttons shown on the left. Alternatively, you can also press the function keys [F2] (forward) and [F3] (backward) to browse through the module
windows.
To save the input, click [OK]. Thus, you exit RF-FE-LTB and return to the main program. To exit
the module without saving the data, click [Cancel].

3.1

General Data

In the 1.1 General Data window, you specify the sets of members and actions for the design.

Figure 3.1: Window 1.1 General Data
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Design of

Figure 3.2: Analysis of sets of members

Only sets of members of the 'continuous members' type can be analyzed. If sets of members are
already defined in RFEM, it is possible to enter their numbers in the list or to select them graphically in the RFEM work window upon clicking []. By selecting the All check box, you can select
all sets of members available in the model for the design.
The design is only possible for the set of members type 'continuous members' (with connected
members that do not branch out). A set of members of the type 'group of members' leads to
an error message before the calculation.

Figure 3.3: Error message when designing a group of members

To define a new set of members, click [New]. The dialog box known from RFEM appears where
you specify the parameters of the set of members.
During the design of the set of members, the members are analyzed as cut out from the system.
Here, you must consider the boundary conditions of a built-up column or a complete frame as a
whole. This is done in the other input windows of RF-FE-LTB.

Existing Load Cases and Combinations
This section lists all load cases and load combinations created in RFEM.
To transfer the selected entries to the To Design list on the right, click []. Alternatively, you can
double-click the relevant entry. To transfer the entire list to the right, click [].
To make a multiple selection, select the load cases while pressing [Ctrl], as common in Windows.
Thus, you can transfer several load cases at once.
If a load case is marked by an asterisk (*), for example LC 13 in Figure 3.1, it is not possible to
design it: This is a load case without load data or an imperfection load case. When you try to
transfer such a load case, an according warning appears.
Result combinations are not available for selection, because unambiguous internal forces must
be available for the analysis. Result combinations, however, have two values for each location:
maximum and minimum.
Below the list, you find a drop-down list with filter options. They can help you to assign the
entries sorted by load cases, load combinations, or action categories. The buttons have the
following functions:
Select all load cases in the list.
Reverse the selection of the load cases.
Table 3.1: Buttons in window 1.1 General Data
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To Design
The section on the right contains the load cases and load combinations selected for the design.
To remove selected items from the list, click [] or double-click them. To empty the entire list,
that is, transfer it to the right, click [].
By transferring items to the To Design list, the loads of the load cases and load combinations
are automatically entered in the load module windows 2.1 through 2.3. You can edit the load
parameters individually and, if necessary, extend them (see chapter 3.8, page 69). In the navigator of RF-FE-LTB, the selected load cases and load combinations are listed under the entry
Load.

Comment

Figure 3.4: User-defined comment

This input field is available for user-defined comments, for example the current analysis case.
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3.2

Materials

This window is subdivided into two parts. The upper part shows all materials specified in RFEM.
The Material Properties section shows the properties of the current material, that is, the material whose row is selected in the section above.

Figure 3.5: Window 1.2 Materials

Materials not used in the design appear dimmed. Invalid materials are highlighted in read,
changed materials in blue.
Chapter 4.3 of the RFEM manual describes the material properties that are used for the determination of internal forces (Main Properties). The global material library also shows the properties of the materials required for the design. These values are preset (Additional Properties).
To adjust the units and decimal places of the properties and stresses, select Settings → Units
and Decimal Places (see chapter 8.2, page 104).

Material Description
The materials defined in RFEM are preset, but you can always change them. Click the material
in column A to activate this field. Then, click [] or press [F7] to open the material list.

Figure 3.6: List of materials

In compliance with the design concept of the Standard [8], you can select only the materials of
the "Steel" category.

Program RF-FE-LTB © 2013 Dlubal Software GmbH

43

3 Input Data

After the transfer of the material, the design-relevant Material Properties are updated.
If you change the Material Description manually and the new entry is listed in the material
library, RF-FE-LTB also imports the material properties.
The material properties cannot be edited in RF-FE-LTB on principle.

Material Library
The library contains a large number of predefined materials. To open this database, click
Edit → Material Library
or use the button shown on the left.

Figure 3.7: Dialog box Material Library

In the Filter section, the material category Steel is predefined. You can select the desired material grade in the Material to Select list. In the table below, you can check the various properties
of the selected material.
You can also select materials of the category Cast Iron, Aluminum, Stainless Steel, etc., even
though these materials are not covered by the design concept of the DIN 18800. RF-FE-LTB can
perform stability analyses on the basis of an FEM analysis that are not subject to the limitations
of the equivalent member method.
To transfer the selected material to window 1.2 of RF-FE-LTB, click [OK] or [↵].
Chapter 4.3 of the RFEM manual describes how to add, filter, or sort the materials.
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3.3

Cross-Sections

This window manages the cross-sections used for the design.

Figure 3.8: Window 1.3 Cross-Section

Cross-Section Description
The cross-sections defined in RFEM are preset together with their according material numbers.
To change a cross-section, click the entry in column B, thus activating the field. To open the
cross-section table (series) of the currently selected input field, click [Library] or [...] in the input
field, or press [F7] (see the following figure).
In this dialog box, you can select another cross-section or a different cross-section table. If you
want to use a completely different cross-section category, click [Back to Cross-Section Library]
to access the general cross-section library.
Chapter 4.13 of the RFEM manual describes how to select cross-sections in the library.
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Figure 3.9: IS-section table in the cross-section library

You can also enter the new cross-section description directly in the input field. If the entry is
stored in the database, RF-FE-LTB imports the RF-FE-LTB cross-section properties.
A modified cross-section is highlighted in blue.
If different cross-sections are available in RF-FE-LTB and in RFEM, the graphic on the right of
the module window shows both cross-sections.
The lateral-torsional buckling analysis according to DIN 18 800 Part 2, element (323) covers all
monosymmetrical and doubly symmetrical I-shaped cross-sections. Moreover, RF-FE-LTB can
analyze all cross-sections in the library except for the parametric solid cross-section and
SHAPE-MASSIVE cross-sections (see also chapter 2.1.1, page 11). The design also covers the
analysis of SHAPE-THIN sections.

Alpha
For control, this column shows the rotation angle of principal axes α for each section.

Remarks
In this column, you may see notes in the form of footers which are described in more detail at
the bottom of the cross-section list.

Member with tapered cross-section
For tapered members with different cross-sections at the start and end of the member, both
cross-section numbers are shown in two rows according to the definition in RFEM.
RF-FE-LTB also designs tapered members if there is the same number of stress points for the
start and end cross-section. The normal stresses are computed from the second moments of
area and the centroid distances of the stress points. If there is a different number of stress
points for the cross-section at the start and the end of the tapered member, the intermediate
values cannot be interpolated. The calculation is therefore impossible in RFEM or RF-FE-LTB.
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You can also graphically check the stress-points of the cross-section including the numbering:
Select the cross-section in window 1.3 and click [Info]. The dialog shown in Figure 3.10 appears.
To carry out a successful design of a taper, you therefore have to achieve an equal amount of
stress points. To do this, you can, for example, model the cross-section at the end of the tapered member as a copy of the cross-section at the start and only modify the geometric parameters. It might also be necessary to model both cross-sections as parameterized ('welded')
sections. For tapered members, the parameterized tapered [IVU]-I-Section Plus Lower Flange is
particularly well suited.

Info About Cross-Section
In the Info About Cross-Section dialog box, you can view the cross-section properties, stress
points, and c/t cross-section parts.

Figure 3.10: Dialog box Info About Cross-Section

The current cross-section is shown in the right part of the dialog box.
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The buttons below the graphic have the following functions:
Button

Function
Displays or hides the stress points
Displays or hides the c/t-parts
Displays or hides the stress points or c/t-parts
Displays the stress points or c/t-parts (see Figure 3.11)
Displays or hides the dimensioning of the cross-section
Displays or hides the principal axes of the cross-section
Returns to the full view of the cross-section

Table 3.2: Buttons of the cross-section graphic

To see specific information about stress points (stress point distances, statical moments, warping ordinates, etc.), and c/t-parts, click [Details].

Figure 3.11: Dialog box Stress Points of HE B 360
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3.4

Nodal Supports

In window 1.4, you specify the support conditions on the member nodes of the set of members
notionally singled out from the system. The nodal supports defined in RFEM are preset; if necessary, they can be adjusted.
You can define additional supports, for example, to represent the lateral restraint by an eaves
purlin in the spatial model of RFEM. If this support is missing in the model of the notionally
singled out set of members, instabilities become possible.

Figure 3.12: Window 1.4 Nodal Supports

The supports and springs are centrically related to the global coordinate system of RFEM (see
chapter 2.2.3, page 15).
The stabilizing effect of objects connected along the set of members can be considered in the
following window 1.5 Elastic Member Foundations (see chapter 3.5, page 55). There, the translational and rotational spring constants of purlins, bracings, and trapezoidal sheeting can be
represented with eccentricities and as continuous supports.

Set No.
In this column, you specify the set of members for which the support conditions apply.
To insert an additional nodal support, place the cursor in a free cell of this column. Next, enter
the number of the set of members or select it in the list. Then, you can specify the supported
nodes in the Nodes column.

Nodes No.
You can specify the nodes with support properties individually or as list. Alternatively, you can
also click [...] (see Figure 3.12) to graphically select them in the RFEM work window.
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Support / restraint or spring
In the columns C to H, you must enter the support conditions of the selected nodes. To activate
or deactivate degrees of freedom of the supports or restraints, select the respective check boxes. Alternatively, you can manually enter the constants of the translational or rotational springs.
To adjust the support conditions, you can also click [Edit] at the end of column B. The following
dialog box appears.

Figure 3.13: Dialog box Edit Nodal Supports

Warping Restraint
Column I manages the warping parameters of the supported nodes. You can specify a full or
no warping restraint and enter the constants of warp springs manually.
The restraint of the warping increases the torsional stiffness of a beam with an open thinwalled cross-section. For the theoretical descriptions to determine warp springs, see chapter
2.5.3, page 29.
By clicking [Edit] at the bottom of column I, you can easily determine the warping constants
resulting from the geometrical conditions. RF-FE-LTB calculates the warp springs for the following types of stiffeners:
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•

End plate ( chapter 2.5.3, page 29)

•

Channel section ( chapter 2.5.3, page 30)

•

Angle ( chapter 2.5.3, page 30)

•

Connected column ( chapter 2.5.3, page 31)

•

Cantilevered portion ( chapter 2.5.3, page 29)

Program RF-FE-LTB © 2013 Dlubal Software GmbH

3 Input Data

Warp spring from end plate

Figure 3.14: Dialog box Edit Warp Spring, type End plate

You can change the predefined Material of the end plate by using the material library.
Furthermore, you can manually enter the geometry of the End Plate Dimensions. To access the
cross-section connected to the nodal support to import its width and depth to the dialog box,
click [Import dimensions of cross-section].
The Resulting warp spring is shown in the lower-right corner of the dialog box.

Warp spring from channel section

Figure 3.15: Dialog box Edit Warp Spring, type Channel section

You can change the predefined Material of the channel section using the material library.
Moreover, you can manually enter the Channel Dimensions. To access the cross-section library
of all channel sections to import the relevant geometric parameters in the dialog box, click
[Select channel from the library and import the dimensions].
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To select the distance of the flange centerlines hm and the web thickness s of the member
cross-section graphically on the cross-section, use [].

Figure 3.16: Dialog box Select Distance

The Resulting warp spring is shown in the lower-right corner of the dialog box.

Warp spring from angle

Figure 3.17: Dialog box Edit Warp Spring, type Angle

The preset Material of the angle can be changed in the material library.
You can enter the dimensions of the Equal Angle manually. To access the cross-section library
of all angle sections in order to import the relevant geometric parameters in the dialog box,
click [Select angle from library and import the dimensions].
You can graphically select the distance of the flange centerlines hm and the web thickness s of
the member cross-section upon clicking [].
The Resulting warp spring is shown in the lower-right corner of the dialog box.
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Warp spring from connecting column

Figure 3.18: Dialog box Edit Warp Spring, type Connecting column

To change the predefined Material of the column, use the material library.
You can select the cross-section of the column in the list. Alternatively, you can select it graphically in the RFEM work window upon clicking []. To select a new cross-section for the column,
click [Library]. The cross-section of the frame beam is automatically preset, but if necessary you
can change it upon clicking [].
To graphically select the distance of the beam's flange centerlines hm on the cross-section, click
[] (see Figure 3.16).
The Resulting warp spring is shown in the lower-right corner of the dialog box.
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Warp spring from cantilevered portion

Figure 3.19: Dialog box Edit Warp Spring, type Cantilevered portion

To change the predefined Material of the beam, use the material library.
The cantilevered Cross-section is predefined as the cross-section of the beam, but you can also
change it graphically in the RFEM work window upon clicking []. To access the cross-section
database and select a new cross-section, click [Library].
You can enter the cantilever length lk directly or specify it by clicking two nodes in the RFEM
model upon clicking [].
The Resulting warp spring is shown in the lower-right corner of the dialog box.

Comment
In the last column of window 1.4, you can enter your own comments for every set of members
to describe, for example, the selected boundary conditions.
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3.5

Elastic Member Foundations

If there are continuous supports for sets of members, for example, due to trapezoidal sheeting,
you can define them in window 1.5. The trapezoidal sheets supporting the beams result in a
rotational restraint of the frame beams and also act as shear panel (see chapter 2.4, page 22). In
addition to this, you can consider the stabilizing effect of purlins and bracings in this window.
The determination of the spring constants is described in the chapters 2.5.1 and 2.5.2, page 25f.
If trapezoidal sheeting is used as shear panel, it is absolutely necessary to satisfy the conditions
stated in the standards, see [13].

Figure 3.20: Window 1.5 Elastic Member Foundations

The springs are relative to the local coordinate system. They act constantly along the member
(see chapter 2.2.3, page 16).

Set No.
In this column, you specify the set of members for which the support conditions apply.
To define a member foundation, place the cursor in a free cell of the column. Then, enter the
number of the set of members or select it in the list. Next, define the member with the elastic
foundation in the Member column.

Member No.
You can enter the members with elastic foundation individually or as list. Alternatively, you can
click [...] (see Figure 3.20) to select them graphically in the RFEM work window.

Elastic foundation Cy / Cz / Cϕ,x
In the columns C through E, you specify the translational and rotational spring constants of the
selected members. By clicking in a cell, a list becomes available that allows for an automatic
determination of the spring constants. Alternatively, you can enter the constants of the translational or rotational springs manually.
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To determine the spring constants by the program, click [Edit] below column B. The following
dialog box appears.

Figure 3.21: Dialog box Edit Elastic Member Foundation

The button [Edit] in the Spring Constants section (marked in Figure 3.21) allows accessing the
program-internal determination of the translational and rotational spring constants for different types of continuous supports:
•

Shear panel ( chapter 2.4, page 23)

•

Bracing ( chapter 2.4, page 24)

•

Trapezoidal sheeting ( chapter 2.4, page 23)

•

Purlins ( chapter 2.4, page 25)

•

Section ( chapter 2.5.1, page 26)

After clicking the button, the Calculate Translational and Rotational Springs from Shear Panel
appears (see Figure 3.22). The dialog box is subdivided into several tabs that are described in
the following pages.
The options and check boxes selected in the Active section control which tabs below are available for further specifications. You must specify, whether there is only a lateral restraint, only a
rotational restraint, or if both actions should be considered simultaneously.
The Lateral Restraint can be due to bracing, trapezoidal sheeting, or to both influences. As a
rule, the lateral restraint acts in the direction of the member axis y. However, you can also
change it to the member axis z in the Determined Translational Spring section.
The Rotational Restraint of the frame beams is either due to a trapezoidal sheet or by purlins,
depending on whether the roof sheeting is spanned without purlins between the beams or is
placed on purlins.
In the Determined Translational Spring and Determined Rotational Restraint sections, the constants of the springs are shown, which the program calculates from the specifications.
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Shear Panel

Figure 3.22: Dialog box Calculate Translational and Rotational Springs from Shear Panel, tab Shear panel

You must specify the length of the shear panel lS and the distance a of the beams to be stabilized. You can also specify the values graphically in the RFEM work window by clicking the two
nodes after you click [].

Bracing

Figure 3.23: Dialog box Determine Translational and Rotational Spring from Shear Panel, tab Bracing
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In the Geometry section, you enter the Number of trusses m stabilizing the roof plane. You can
enter the distance b of the bracing posts directly. Alternatively, you can click [], and then
specify them directly in the RFEM work window by clicking two nodes.
You can enter the cross-sectional area of the Diagonals and Posts or determine them from the
cross-section properties. You can specify the cross-sections by using the lists or graphically by
clicking []. To select a new cross-section, click [Library].
You can change the preset Material of the diagonals and posts using the list or the [Library]
button. Furthermore, you can also directly specify the modulus of elasticity.

Corrugated Sheet

Figure 3.24: Dialog box Calculate Translational and Rotational Springs from Shear Panel, tab Corrugated Sheet

The Corrugated Sheet (trapezoidal sheet) can be selected from a [Library] of common corrugated sheets (see Figure 3.25). The shear field coefficients K1 and K2, the moment of inertia Ief, and
the sheet thickness t are automatically filled with the values from the library. If necessary, you
can manually adjust them.
With the Type of connection options, you decide whether the trapezoidal sheeting is connected
in every rib or in every second rib (groove). The specification has an influence on the rotational
restraint (see chapter 2.4, page 24).
If the trapezoidal sheeting is placed over a minimum of three spans on the frame beams, you
can activate the Continuity effect by selecting the according check box.
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Figure 3.25: Library Corrugated Sheets

In the Rotational Restraint from Connection section, you can specify the coefficient for the rotational restraint c ϑA,k (see chapter2.5.1, page 26). By clicking [], you open Table 7 of DIN 18800
Part 2. Depending on the boundary conditions, you can import the appropriate coefficient into
the initial dialog box by clicking in the according row, and then clicking [OK].

Figure 3.26: Dialog box Coefficient c-ThA,k bar from Table 7, DIN 18800 Part 2

The coefficient for the rotational restraint c ϑA,k can also be determined according to the (more
favorable) method by LINDNER / GROESCHEL [18]. Further specifications are required for this. You
can enter them in a dialog box, which you open by clicking [Edit] in the lower part of the Corrugated Sheet tab.
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Figure 3.27: Dialog box Calculate c-ThA,k According to Lindner/Groeschel

In the Profiled Steel Sheeting section, you specify the fastening width b of the trapezoidal sheeting on the beam. In addition, the position of the trapezoidal sheeting, its thickness t, as well as
the Loading A is to be specified as design value of the support force of the trapezoidal sheeting. From these specifications, the program determines the Correction Factors kb, kt, and kA.
The coefficient c ϑA,k of the rotational restraint can be directly selected from Table 7 of DIN 18800
Part 2 (see Figure 3.26). Below in the dialog box, you can see the computed rotational spring.
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Purlins

Figure 3.28: Dialog box Calculate Translational and Rotational Springs from Shear Panel, tab Purlins

In the Geometry section, you specify the distance of the purlins e. You can also specify the distance graphically in the RFEM work window by selecting two nodes after clicking [].
The predefined Material of the purlins can be changed by means of the list or the material library. The modulus of elasticity is imported to the input field and can by adjusted, if necessary.
Upon clicking [], you can determine a member to import its material.
The Cross-Section of the purlins can be specified by clicking [], and then clicking a member in
the RFEM work window. To select a different cross-section for the purlin, click [Library]. Its
moment of inertia Iy is imported to the input field below and can be modified, if necessary.
If the purlins cover a minimum of three spans, you can activate the Continuity effect by selecting the according check box.

Program RF-FE-LTB © 2013 Dlubal Software GmbH

61

3 Input Data

Section

Figure 3.29: Dialog box Calculate Translational and Rotational Spring from Shear Panel, tab Section

You can change the preset Section of the member with the elastic foundation by using the list
or graphically in the RFEM work window upon clicking []. Alternatively, you can select a different section in the [Library].
The compression flange width b1, compression flange thickness t1, web thickness s, and flange
centroid height hm are shown according to the cross-section selection. By clicking [], you
open the cross-section graphic in which you can specify the relevant cross-section parts or
distances by clicking them (see Figure 3.16, page 52).

Eccentricity ey /ez
In the columns F and G of window 1.5 (see Figure 3.20, page 55), you can specify the eccentricities of the elastic member foundations. They refer to the local member axes y and z (or u and
v for unsymmetric cross-sections). The distances of the springs from the cross-section centroid
can also be adjusted in the Edit Elastic Member Foundation dialog box (see Figure 3.21, page
56).
Upon clicking […] in the table row or [] in the dialog box, you can specify the eccentricities in
the cross-section graphic by clicking the relevant stress points (see Figure 3.16, page 52).

Comment
In the last column of this window, you can specify user-defined comments for each set of
members, for example, the selected boundary conditions.
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3.6

Member End Springs

In window 1.6, you can limit the degrees of freedom at the nodes of selected members by
means of translational, rotational, and warp springs. In the set of members model, you can
thus represent, for example, the warping restraint of a frame beam by means of an end plate
connection.

Figure 3.30: Window 1.6 Member End Releases

The boundary conditions defined here are to be seen in their interaction with the nodal support parameters of window 1.4. Therefore, you have to take care during the input that no double releases or such like are defined.
In contrast to the nodal supports of window 1.4, you can also define eccentricities for the single springs.

Set No.
Define for which set of members the springs parameters should apply.
To define a member end spring, place the cursor in a free cell of this row. Then, you can enter
the number of the set of members or select it in the list. In the Member column, specify the
members with springs at their ends.

Member No.
You can enter the members with end springs individually as list or select them graphically in
the RFEM work window upon clicking [...] (see Figure 3.30)

Member Side
After you click in a cell, the [] button appears. By clicking it, you can access the list shown on
the left. There you can select at which member end the release spring is located.
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Spring constant Cy / Cz / Cϕ,x / Cy
In the columns D through G, you specify the translational, rotational, and warping constants
for the selected member sides (see chapter 2.5, page 25). The spring constants relate to the
local member axes y, z, and x (or u and v for unsymmetric cross-sections).
To manually enter the spring constants, click in the cells. Alternatively, you can click [] to
open the list and Define them in a dialog box.
You can determine the member end springs also in the program upon clicking the [Edit] button located below column B. The following dialog box appears.

Figure 3.31: Dialog box Edit Member End Springs

Translational spring
By clicking [Edit] in the Spring Constants section (Figure 3.31), you open a dialog box where you
can consider the support of the member end by a connecting component. From the geometric
parameters, the program determines the constant of the translational spring at the member
end in the local y- or z-direction of the member.

Figure 3.32: Dialog box Calculate Translational Spring Using the Connecting Component
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To select the Material and the Cross-section of the connecting component, use the drop-down
list or the material and section [Library]. To specify the Length L of the component [], you can
either enter it or select it in the RFEM work window by clicking two nodes.
To transfer the material, cross-section, and length of a graphically selected member, click
[Import Member Properties].

Rotational Spring
By clicking [Edit] in the Spring Constant section (Figure 3.31), you open another dialog box
where you can consider the elastic restraint at the end of the member resulting from a connected column. From the geometric parameters, the program determines the constant of the
rotational spring at the member end acting about the local x-direction of the member.

Figure 3.33: Dialog box Calculate Rotational Spring Using the Connected Column

To select the Material and the Cross-Section of the connected column, you can use the dropdown list or the material and section [Library]. To specify the Length L of the column, you can
either enter it or use [] to select it in the RFEM work window by clicking two nodes.
To transfer the material, cross-section, and length of a graphically selected column, click
[Import Member Properties].
The Support Type of Column About Axis z also influences the rotational spring Cφ,1 of the beam
(see dialog graphic). In addition to a pinned and rigid support, the degree of restraint can be
freely defined between 0 % (pinned) and 100 % (rigid).
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Warp spring
The restraint of warping increases the torsional stiffness of the beam. The [Edit] button in the
Spring Constants section (Figure 3.31) allows you to open a dialog box where you can consider
the warp spring by warp stiffening. From the geometric parameters, the program determines
the constant of the warp spring active on the member end.

Figure 3.34: Dialog box Edit Warp Spring

The theoretical background on determining the warp springs is provided in chapter 2.5.3,
page 29f. The warp spring can be defined by means of an end plate, a channel section, an
angle, a connected column, or a cantilevered portion.
The Edit Warp Spring dialog box is described in chapter 3.4, page 51f.

Eccentricity ey /ez
In the columns H and I of window 1.6 (see Figure 3.30, page 63), you can specify the eccentricities of the springs. They refer to the local member axes y and z (or u and v for unsymmetric
cross-sections) and are relevant for the spring constants Cy and Cz. The distances of the springs
from the cross-section's centroid can also be defined in the Edit Member End Springs dialog box
(see Figure 3.31, page 64).
To specify the eccentricities in the cross-section graphic by clicking the relevant stress point,
click […] in the table cell or [] in the dialog box (see Figure 3.16, page 52).

Comment
In the last column of the window, you can enter user-defined comments for each spring, for
example, to describe the spring parameters.
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3.7

Member End Releases

In window 1.7, you can define the member end releases for individual members in the set of
members; this is done independently of RFEM. The releases defined in RFEM are preset for the
members of the set of members.

Figure 3.35: Window 1.7 Member End Releases

Set No.
You must specify for which set of members the release conditions should apply.
To define a member end release, place the cursor in a free cell of this column. Then, you can
enter the number of the set of members or select it in the list. In the Members column, specify
the members with the releases at their ends.

Member No.
The members with end releases can be entered individually or graphically in the RFEM work
window upon clicking [...] (see Figure 3.35)

Member Side
After you click in a cell of this column, the [] button appears that you can use to open the list
on the left. In the list, you can select, at which member end the release exists.

N-/V-Release
In the columns D, E, and F, you can specify for the selected member sides the release parameters controlling the transfer of axial and shear forces. The internal forces are relative to the local
member axis system xyz.
To control the degrees of freedom, use the relevant check boxes: If you select a check box, the
respective internal force is not transferred. Spring constants are not permitted.
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T-/M-Release
In the columns G, H, and I, you can specify for the selected member sides the release parameters controlling the torsional and bending moments. These internal forces are relative to the
local member axes.
To activate or deactivate the DOF, use the check boxes: If you select a check box, the moment
is not transferred. Spring constants are not permitted.

Warping
The column J controls whether the warping torsional moment can be transferred at the selected member sides. If you select the check box, there is a release; the moment is not transferred.
To adjust the release parameters, click [Edit]. The following dialog box appears.

Figure 3.36: Dialog box Edit Member End Release

Comment
In the last column of the window, you can enter user-defined comments for each member end
release, for example, to describe the release parameters.
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3.8

Load

There are three windows to enter the load. To select them, use the tabs at the bottom of the
main window:
•
•

2.1 Nodal Loads
2.2 Member Loads

•

2.3 Imperfections

In the navigator on the left under the Load entry, you can see all load cases and load combinations selected in window 1.1 General Data for design. There, you must first select the entry
whose load data you want to define.
If you defined nodal and member loads in RFEM for the members contained in the set of members, they are preset in the window 2.1 Nodal Loads and 2.2 Member Loads. You can change the
loads, if necessary. Imperfections, however, are not imported: You must define them in the 2.3
Imperfections window depending on the eigenvalue.
Caution! If structural components that do not belong to the set of members introduce loads
to the set of members like, for example hall frame with craneway consoles or 3D halls with purlin roofs, the loads are not automatically imported from RFEM. It is absolutely necessary that
you add these loads so that the model of the notionally singled out set of members can be
created correctly! As a rule, you can define the introduced loads as additional nodal loads. For
eccentrically acting additional loads, however, we recommend the 2.2 Member Loads window.

3.8.1

Nodal Loads

You enter the loads for the load case or load combination that you selected on the left in the
navigator.

Figure 3.37: Window 2.1 Nodal Loads

Set No.
In this column, you specify for which set of member the nodal loads are effective. All nodal
loads that you defined in RFEM for the nodes in the set of members are preset.
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To insert an additional nodal load, place the cursor in a free cell of this column. Then, you can
enter the number of the set of members or select it in the list. In the Nodes column, you specify
the loaded nodes.

Node No.
You can specify the nodes subject to loads either individually or as list. Alternatively, click [...]
(see Figure 3.37) to select them graphically in the RFEM work window.

Nodal Forces PX / PY / PZ
In the columns C to E, you specify the forces that act on the selected nodes. Thus, you can consider the internal forces introduced in the set of members. These internal forces are transmitted as axial and shear forces by connecting components (for example craneway console, purlins, or posts): Internal forces of members or surfaces that are not part of the set of members
are not automatically imported from RFEM! You must define these additional loads manually.
The nodal forces in this window are relative to the global XYZ coordinate system. Thus, it can
be necessary to transform the local RFEM internal forces of members (xyz coordinate system).

Nodal Moments MX / MY / MZ
In the columns F through H, you can consider torsional and bending moments that are transmitted at the selected nodes to the set of members. The moments are also relative to the global
XYZ axis system.

Bimoment My
In this column, you can enter additionally acting nodal warping torsional moments. RFEM calculates no internal forces due to warping torsion.
You can also adjust the current nodal load by clicking [Edit] below the list of nodal loads. The
following dialog box appears.

Figure 3.38: Dialog box Edit Nodal Load

Comment
In the last column of this window, you can write your own comments, for example to describe
the additionally acting nodal load.
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3.8.2

Member Loads

In window 2.2, all member loads are preset that were defined in RFEM for the members contained in the set of members. If loads transmitted eccentrically to the continuous members are
considered, they can be taken into account as additional individual forces or moments.
You specify the loads for the load case or load combination that you selected in the navigator
on the left.

Figure 3.39: Window 2.2 Member Loads

For loads and load combinations whose automatic self-weight are deactivated in RFEM, the
Consider self-weight check box is available. It controls whether or not the members contained
in the set of members are also applied in RF-FE-LTB. If you select the check box, the self-weight
factor defined in RFEM is entered taking into account the load case factor.

Reference to
In the list of this cell, you specify whether the load acts on individual members, a list of members, or the entire set of members. The effect of the reference possibilities is described in chapter 6.2 of the RFEM manual.
To insert an additional member load, you have to place the cursor in a free cell of the column
and specify the reference of the load. In the next column, you can specify the Numbers of the
loaded objects.

Members / List of Members / Sets of Members No.
To specify the members or sets of members subjected to loads, you can enter them individually or as list. You can also select them graphically in the RFEM work window upon clicking [...]
(see Figure 3.39)

Load Type
The list contains all types of member loads of RFEM (see chapter 6.2 of the RFEM manual).
The current version of RF-FE-LTB supports only Forces and Moments.
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Load Distribution
For forces, the list shown on the left presents the available load distributions (except for the
parabolic distribution). They are described in chapter 6.2 of the RFEM manual.
Moments can also be considered in RF-FE-LTB if they are defined as concentrated single or
multiple loads. Distributed moments are not supported in the current version.

Load Direction
The force or the concentrated moment can act in the direction of the global axes X, Y, and Z or
of the local member axes x, y, and z (or u and v for unsymmetrical cross-sections). The load reference axes are described in chapter 6.2 of the RFEM manual.
For the analysis in RF-FE-LTB, it is unimportant whether a load is defined locally or, equivalently, as global.

Reference Length
The load entry can be relative to a total, true member or set of members length, or to the projection of the member or set of members in one direction of the global coordinate system.

Parameters of member load P / M / p / p1 / p2 / n / A / B
Columns G through J define the load magnitudes for P, M, or p, and possible additional parameters. The input fields are enabled and accordingly named depending on the previously activated entries.
The parameter n describes the number of concentrated loads; the parameters A and B describe
the distances of the load from the start of the member / set of members.

Distance in %
If you select the check box in column K, the distances of concentrated or trapezoidal loads can
be defined relative to the length of the member or set of members.

Over Total Length
You can select the check box in column L only in case of trapezoidal loads. It has the effect that
the linearly variable load is distributed from the start to the end of the member or set of members. Then, the columns I and J become available.

Eccentricity ey /ez
In the columns M and N, you can define eccentricities for the point of application of the load.
The eccentricities refer to the local member axes y and z.
The program applies global line loads in the shear center and local line loads in the centroid
(see Figure 2.3 and Figure 2.9). Vertical loads often act in the neutral axis of the cross-section.
For monosymmetrical cross-sections like channel sections, you therefore have to consider that
the shear center and centroid have a different position. By means of the eccentricity ey in column M, you can consider an intended torsion.
Moreover, the load often does not act at the height of the shear center but at the top of the
cross-section. This eccentricity can be defined in column N. For the load application at the top
flange, please take care of the fact that you must specify a negative value for ez.
To specify the eccentricities in the cross-section graphic, click […] in the table cell or [] in the
dialog box, and then click the relevant stress point (see Figure 3.16, page 52).
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To edit the parameters of the current member load, click [Edit] below the table. The following
dialog box appears.

Figure 3.40: Dialog box Edit Member Load

Comment
In the last column of this window, you can write your own comments, for example, to describe
an additional eccentric member load.
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3.8.3

Imperfections

RF-FE-LTB does not use equivalent loads but runs its own calculation of the eigenvectors.
Therefore, you must separately define the imperfections in window 2.3. The geometric equivalent loads of the RFEM imperfection load cases are not considered.
According to DIN 18800 Part 2 [8] and EN 1993-1-1 [9], the imperfections are to be applied according to the mode shape that belongs to the lowest or governing buckling eigenvalue. In
window 2.3, you can specify the relevant eigenvectors and value s (magnitude of imperfection).
You enter the imperfections for the load case or load combination that you selected in the
navigator on the left.
For more details on imperfections, see chapter 2.6.2 on page 37.

Figure 3.41: Window 2.3 Imperfections

Set No.
In this column, you can specify for which set of members the imperfections should apply.
To define a new imperfection, place the cursor in a free cell of this column. Then, you can enter
the number of the set of members or select it in the list.

Eigenvector No.
In column B, you can directly enter or select form the list the number of the governing eigenvector. The first eigenvector, which is often governing, is preset.
A higher eigenvector can be governing for the lateral-torsional buckling. Hence, it is necessary
to analyze various eigenvectors. By clicking [Select Imperfection], you can check the eigenvector graphically in the RFEM work window (see Figure 3.42) and also import it from there in
window 2.3. Here, RF-FE-LTB runs an eigenvalue analysis prior to the actual calculation.
The number of the eigenvectors shown in the list is managed in the Details dialog box (see
chapter 4.1, page 77), which you open by clicking [Details]. The predefined number of imperfection shapes is 10. The Details dialog box allows also you to calculate the eigenvectors without considering rotational and shear panel restraint.
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View navigator:
Rendering of eigenvector

Figure 3.42: Graphical control of the eigenvectors in RFEM work window

Value s
In column C, the magnitude of imperfection is to be specified in [cm]. To determine this reference value from the specifications of the geometry and the standards in a dialog box, click
[Determine Value].
You can determine the magnitude of imperfection by means of the initial sway or initial camber. The specifications in the section Calculate the Magnitude of Imperfection by influence the
view of the dialog box.

Initial sway

Figure 3.43: Dialog box Imperfection, Calculate value by Initial sway
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This method for the determination of the magnitude of imperfection s is recommended for
sway systems. To specify the Reference length L of the governing member or set of members,
you can enter it directly or, after clicking [], select it in the RFEM work window by clicking two
nodes. For a frame, the reference length is usually the length of the column. With the member
length, the reduction factor r1 and the magnitude of imperfection (value s) are determined.
The Number of columns n is used for the calculation of the reduction factor r2. Notice that according to DIN 18800 Part 2, element (205), only those columns may be considered that show
at least 25 % of the axial force of the most loaded column.
In the Elastic-elastic method, the imperfections may be reduced according to DIN 18800 Part 2,
element (201), to 2/3 of the values.

Initial camber

Figure 3.44: Dialog box Imperfection, Calculate value by Initial camber

This method for determining the magnitude of imperfection is recommended for non-sway
systems. To specify the Reference length L of the governing member or set of members, you
can enter it directly or, after clicking [], select it in the RFEM work window by clicking two
nodes.
The buckling curve of the cross-section is to be specified according to DIN 18800 Part 2, Table 5.
For the sections from the library, the buckling curve BCz is preset; you can change it by using
the list, if necessary.
In the Elastic-elastic method according to DIN 18800 Part 2, element (201), it is possible to reduce the magnitude of imperfection to 2/3. In addition, you can reduce the initial camber to
0.5  w0 according to DIN 18800 Part 2, element (202) (see also chapter 2.6.2, page 37).
Below in window 2.3 (see Figure 3.41, page 74), you can use the buttons [Copy Imperfections
to All LC/CO] and [Apply Ordinate to All Sets of Members]. Thus, you can copy the current imperfections for all load constellations to be designed or assign the ordinate (magnitude of imperfection) of the current row to all sets of members.

Comment
The final column allows you to enter your own comments to describe the selected eigenvector
or determine the magnitude of imperfection.
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Calculation

4.1

Detail Settings

Before the calculation, check the design details. You can open the corresponding dialog box in
every window of RF-FE-LTB by clicking [Details].

Figure 4.1: Dialog box Details

Calculation Settings
In RF-FE-LTB, you can run the Calculation of the ultimate capacity: For this analysis of the structural system, you analyze whether the design loads Fd are less than the ultimate capacity FG or
the ultimate capacity FT of the structural system (see chapter 2.6.4, page 39).
The ultimate capacity (limit load) is determined by an iterative load increase (see Figure 2.1,
page 10). For this, you can select from two options which are described in chapter 2.1.4, page
12f:
•

Ultimate capacity due to loss of stability (snap-through load) on the imperfect system
without stress limitation

•

Ultimate capacity due to loss of stability on the imperfect system observing the elastic
limit stress (all normal, shear, and equivalent stresses are smaller or equal to the respective elastic limit stress)

Optionally, you can Consider secondary shear stresses in the calculation.
It is recommended to adjust the preset Lengths of the FE elements to the dimensions of the sets
of members. For short sets of members, the FE lengths should be reduced accordingly. For tapered elements, you can use a separate refinement option to consider the cross-section
changes by an according discretization.
The Number of imperfection shapes has an influence on the eigenvalues in the 2.3 Imperfections
window (see figure on the left margin of page 74).
If the imperfection shapes are determined without rotational and shear panel restraint, then the
eigenvectors, which were computed in window 2.3 on [Select Imperfection], represent "pure"
eigenvectors: They are obtained without considering the different coefficients for translational
and rotational restraints due to stabilizations.
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Partial Factor
If the check box in the section is selected, the stiffnesses E  I or E  A are divided by the material
partial safety factor iM. This coefficient can be specified separately for each material in RFEM.

Iteration Parameters
The critical load factor is determined iteratively. You can influence the calculation procedure
and the convergence behavior by means of the input fields. As a rule, it is not necessary to
change the preset values.
Starting with the Start Nu-Factor ν ("nu"), the loading is continuously increased according to
the defined Increment until the system becomes unstable. The Maximum Nu-factor (Maximum
load factor ν) is limited to 10, since, according to DIN 18800 Part 1, element (728), a secondorder stability analysis is no longer necessary beyond this value.
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4.2

Start Calculation

You can start the calculation from every input window of the module RF-FE-LTB by clicking
[Calculation].
RF-FE-LTB runs an independent analysis on the notionally singled out model. Therefore, it is
not important whether the internal forces of the load cases and load combinations to be designed were calculated in RFEM.
You can also start the calculation in the RFEM user interface: The To Calculate dialog box (menu
Calculation → To Calculate) lists the design cases of the add-on modules like load cases or load
combinations.

Figure 4.2: Dialog box To Calculate

If RF-FE-LTB cases are missing in the Not Calculated list, use the drop-down list at the left bottom
of the dialog box to change the display to All or Add-on Modules.
To transfer the selected RF-FE-LTB cases to the list on the right, click []. To start the calculation,
click [OK].
You can also directly calculate a design case by using the list in the toolbar: Select the relevant
RF-FE-LTB case, and then click [Show Results].

Figure 4.3: Direct calculation of a RF-FE-LTB design case in RFEM

You can then follow the calculation in a solver window.
If more and more memory is used and the calculation takes a long time, no convergence can be
reached during the iteration: The notionally singled out model of set of members is instable. After some time, the Calculation Errors and Notes (see Figure 5.10, page 89) appears. Often, you can
resolve the problem by adjusting the support conditions.
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5.

Results

After the successful calculation, the 3.1 Stresses by Cross-Section window appears. If only window 3.8 Critical Load Factors appears, this means that the model is instable because the loading is too large: The critical load factor is less than 1.

Figure 5.1: Results window with stresses in table and cross-section graphic

The stresses are sorted in the results windows 3.1 through 3.4 by various criteria.
Windows 3.5 and 3.6 list the internal forces and deformations of the sets of members. Window
3.7 provides information on the support forces.
The final window, 3.8, shows the critical load factors. In this window, you should check if all
critical load factors are greater than or equal to 1: Only then is the stability of the system ensured!
To go directly to a module window, click the according entry in the navigator. To go to the
previous or next module window, use the buttons shown on the left. You can also browse
through the windows using the function keys [F2] and [F3].
To save the results, click [OK]. Thus, you exit RF-FE-LTB and return to the main program.
Chapter 5 Results presents the results windows one by one. For details on evaluating and
checking the results, see chapter 6 Results Evaluation, page 90f.
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5.1

Stresses by Cross-Section

This window shows for all analyzed cross-sections the maximum stress ratios that result from
the loadings of the governing load cases and load combinations.

Figure 5.2: Window 3.1 Stresses by Cross-Section

The list is sorted by cross-section. For a taper, the table shows both cross-section descriptions.

Stress Type
RF-FE-LTB analyzes the following stress types:
• Normal stresses σ
• Shear stresses τ
• Equivalent stresses σeqv
The normal stress Sigma is determined from the stress components of the axial force N, bending moments My and Mz, as well as the warping torsional moment My (see Equation 2.4, page
20).
The shear stress Tau is determined from the shear forces Vy and Vz and the torsional moment
MT (see Equation 2.5, page 20).
The equivalent stress Sigmaeqv is determined from the parts of normal stress σ and shear
stress τ (see Equation 2.7, page 21).

Member No.
This column shows the respective number of the member with the highest stress ratio.
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Location x
At this x-location of the member, the maximum ratio occurs. For the tabular and graphical
output, the following member locations x are used:
•

Start and end node

•

FE division points

This reflects the FE length that is specified in the Details dialog box (see chapter 4.1, page 77).
For the calculation, the members are divided into finite elements acc. to the specification.
The member and FE divisions in RFEM are of no relevance for RF-FE-LTB.

Stress Point
The design is carried out on so-called stress points of the cross-section. The locations are defined by centroidal distances, statical moments, and thicknesses of the cross-section parts,
which allow for a design according to Equation 2.4 and Equation 2.5.
All standard cross-sections of the library as well as the SHAPE-THIN and SHAPE-MASSIVE crosssections have stress points at the design-relevant locations of the cross-section. For user-defined cross-sections, you must specify the parameters of the stress points manually to enable a
design in STEEL.
In the cross-section graphic on the right, the stress points are shown with their numbers. The
current stress point (that is, the stress point of the currently selected row) is highlighted in red.
To control the properties of the stress points, click [Info] (see chapter 6.1, page 92).
The normal and shear stresses are determined at each single stress point. For the equivalent
stresses, it is therefore necessary to consider the stress components at which the same stress
points exist. Therefore, it is usually not correct to superimpose the maximum stresses σ and τ
shown in window 2.1: Usually, they occur at different stress points! You can view and evaluate
specific results in window 3.4 Stresses by Stress Point (see chapter 5.4, page 84).

Load Case
This column shows the number of the load cases and load combinations whose loads result in
maximum utilization ratios.

Stress Exist
Column F shows the extreme values of the existing stresses determined according to Equation
2.4, Equation 2.5, and Equation 2.7 (see pages 20 and 21).

Stress Limit
This column shows the limit stresses of window 1.2 (see chapter 3.2, page 43). In particular, this
includes the following limit stresses:
• Limit normal stress σ as the allowable stress for the stress due to shear force, bending,
and warping
• Limit shear stress τ as allowable shear stress due to shear force and torsion
• Limit equivalent stress σeqv as the allowable equivalent stress for the simultaneous
action of normal and shear stresses

Stress Ratio
The last column shows the quotient from existing and limit stress. If the limit stress is not exceeded, then the ratio is less than or equal to 1 and the stress check is satisfied.
The length of the colored scale presents the respective ratio in graphical form.
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5.2

Stresses by Set of Members

Figure 5.3: Window 3.2 Stresses by Set of Members

This window lists the maximum stresses sorted by set of members.

5.3

Stresses by x-Location

Figure 5.4: Window 3.3 Stresses by x-Location
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This window lists the stresses that occur at the FE division points acc. to the specifications in
the Details dialog box (see page 77). The individual columns are described in chapter 5.1.

5.4

Stresses by Stress Point

Figure 5.5: Window 3.4Stresses by Stress Point

The list is sorted for each member by x-Location and Stress Point. The individual columns of this
window are described in chapter 5.1.
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5.5

Internal Forces

Figure 5.6: Window 3.5 Internal Forces

For each member, this window shows the internal forces that are available for all analyzed load
cases and load combinations at the FE division points.

x-Loc.
The following member x-locations are used for the tabular and graphical output:
• Start and end node
• FE division points
In case of discontinuities in the internal force diagram, the cut faces are indicated by l (left) or r
(right).

Load Case
This column shows the numbers of the analyzed load cases and combinations.

Forces / Moments
The individual symbols of the internal forces have the following meanings:
N

Axial force

Vy

Shear force in direction of the local member axis y (or u)

Vz

Shear force in direction of the local member axis z (or v)

MT

Torsional moment

My

Bending moment about the local member axis y (or u)

Mz

Bending moment about the local member axis z (or v)

My

Warping torsional moment

MTpri

Primary torsional moment (St. Venant torsion)

MTsec

Secondary torsional moment (warping torsion)

Table 5.1: Internal forces
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It is recommended to compare these internal forces with the internal force diagrams that are
available in RFEM for the respective load cases and combinations. Thus, you can check whether the boundary conditions of the sets of members notionally singled out from the system are
considered correctly (nodal support, loads, imperfections, etc.).

5.6

Deformations

Figure 5.7: Window 3.6 Deformations

For each member, the deformations are shown that exist for all designed load cases and load
combinations at the FE division points. They are relative to the centroid of the cross-section;
RF-FE-LTB does not determine any local cross-section deformations.

x-Loc.
The output is sorted by x-location (start and end nodes, FE division points).

Load Case
This column shows the numbers of the analyzed load cases and combinations.

Displacements / Rotations / Warping
The symbols of the deformations have the following meanings:
uX

Displacement in direction of the global X-axis

uY

Displacement in the direction of the global Y-axis

uZ

Displacement in the direction of the global Z-axis

ϕX

Rotation about the global X-axis

ϕY

Rotation about the global Y-axis

ϕZ

Rotation about the global Z-axis

y

Warping

Table 5.2: Deformations
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5.7

Support Reaction Forces

Figure 5.8: Window 3.7 Support Reaction Forces

Window 3.7 shows the support forces at the individual nodal supports. These are the forces
and moments that are introduced to the supports. Thus the signs of the values are not the
reaction forces from the supports.

Nodes No.
This column lists the numbers of all nodes to which you assigned support properties in the 1.4
Nodal Loads window (see chapter 3.4, page 49).
Nodal supports with spring properties are indicated by an (F).

Load Case
This column shows the numbers of the analyzed load cases and combinations.

Forces / Moments
The symbols of the support forces have the following meanings:
PX

Support force in the direction of the global X-axis

PY

Support force in the direction of the global Y-axis

PZ

Support force in the direction of the global Z-axis

MX

Support moment about the global X-axis

MY

Support moment about the global Y-axis

MZ

Support moment about the global Z-axis

My

Warping torsional moment at support

Table 5.3: Support forces and moments
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5.8

Critical Load Factors

Figure 5.9: Window 3.8 Critical load factors for determining Ncr or Mcr

The last results window allows you to evaluate the stability behavior of the sets of members:
It shows the critical load factors that are available for all analyzed load cases and load combinations.

Set No.
The critical load factors are shown sorted by set of members.

Load Case
This column shows the numbers of the load cases and load combinations of those loads that
result in the respective load factors.

Critical Load Factor
A critical load factor of for example 1.5860 (see Figure 5.9) means that this load combination
has to be increased by the factor 1.5860 for the system to become instable (that is, the diagonal
coefficient of the matrix is smaller than zero). An elastic behavior of the material is assumed.
If the critical load factor is smaller than 1, this means that the system has already become instable before the design load is reached. After the calculation, it is therefore also important to
check if, in addition to the stress ratio (see window 3.1), all critical load factors are greater than
or equal to 1.
If RF-FE-LTB determines a critical load factor of 0 during the iterations, a convergence can be
reached: This means, there is a general instability and the Calculation Errors and Notes window
appears (see Figure 5.10). In this case, the definitions of supports and releases should be
checked. The system notionally singled out from the RFEM model is mostly likely to be kinematic.
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Figure 5.10: Window Calculation Errors and Notes

Number of Iterations
Thus column shows how many iterations it takes to reach the instability.

Reason for Interruption in the Calculation
The comments provide information about the stability behavior of individual sets of members.
In the Details dialog box, you can specify the iteration parameters (see Figure 4.1, page 77).

Program RF-FE-LTB © 2013 Dlubal Software GmbH

89

6 Results Evaluation

6.

Results Evaluation

The design results can be evaluated in different ways. For this, the buttons at the end of the
table are also useful.

Figure 6.1: Buttons for results evaluation

The buttons have the following functions:
Button

Description

Function

Relation scale

Shows or hides the colored relation scales in the results
window

Exceeding

Shows only rows where the ratio is greater than 1, that is,
the check is not fulfilled

Result diagrams

Opens the Result Diagram on Member dialog box
 chapter 6.3, page 97

Excel export

Export the table to MS Excel / OpenOffice
 chapter 8.3.3, page 106

Member selection

Allows you to select a member graphically to show its
results in the table

View mode

Allows you to switch to the RFEM work window in order
to change the view

Table 6.1: Buttons in the results windows
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6.1

Results on Cross-Section

The tabular results are illustrated by a dynamic stress graphic. This graphic shows the stress
diagram on the cross-section, which is present at the current x-location for the selected stress
type. If you select a different x-location or type of stress by clicking it, the display is updated
too. The governing stress point is highlighted in red.
In the graphic, you can show stresses as well as the stress ratios.

Figure 6.2: Distribution of the normal stresses on the cross-section

The buttons below the graphic have the following functions:
Button

Description

Function

Stress diagram

Shows or hides the display of stresses

Stress ratio

Shows or hides the ratios

Values

Shows or hides the results values

Cross-section outlines Shows or hides the cross-section outlines
Stress points

Shows or hides the stress points

Numbering

Shows or hides the numbers of the stress points

Show all graphic

Restores the total view of the results graphic

Table 6.2: Graphic button in the windows 3.1 through 3.4.
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You can zoom in or out using the mouse wheel. To shift the stress graphic, you can use the
drag-and-drop function. To return to the global view, click [Show all graphic].

Cross-section properties and stress points
To view the properties of the cross-sections and stress points, click [Info]. The Info About CrossSection dialog box with the cross-section properties appears.

Figure 6.3: Dialog box Info About Cross-Section

To view information on the stress points, click [Details].

Figure 6.4: Dialog box Stress Points
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The columns Coordinates show the centroidal distances y and z of the stress points. The columns Statical Moments of Area show the statical moments of area Qy and Qz (or Qu and Qv for
unsymmetric cross-sections). The Thickness t of the structural component at the stress point is
necessary for the determination of shear stresses.
The columns Warping provide information on the warping ordinates Wno and the warping statical moment Sw. For closed cross-sections, the last column shows the core area A* of the cell
that is necessary to determine the Bredt torsional shear stresses.

6.2

Results on RFEM Model

For the evaluation, you can also use the RFEM work window.

RFEM background graphic and view mode
The RFEM work window in the background helps you find the position of a member in the
model. In the background graphic, the member selected in the results window of RF-FE-LTB
is highlighted by color. An arrow also indicates the x-location of the member selected in the
table row.

Figure 6.5: Indication of the member and the current x-loc. in the RFEM model

If it is not possible to improve the view by moving the RF-FE-LTB window, click [Jump to
graphics to change view] to start the View Mode: Now, the module window is hidden so that
you can adjust the view in the RFEM work window. In the view mode, you can use the functions of the View menu, for example, zoom, move, or rotate the view. The arrow remains visible.
To return to RF-FE-LTB, click [Back].
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RFEM work window
The stresses, ratios, deformations, internal forces, and eigenvectors can also be evaluated
graphically on the RFEM model: Click [Graphics] to quit RF-FE-LTB. The work window of RFEM
now shows the results like the internal forces or deformations of a load case.
The Results navigator is adjusted to the checks in the RF-FE-LTB module. It provides various
stress types, stress ratios, internal forces, and eigenvectors for selection.

Figure 6.6: Results navigator for RF-FE-LTB

The normal stresses are shown separately by tensile (+) and compression stresses (-). Graphically, you can also evaluate the internal forces and deformations for each analyzed load case
or each load combination.
Similarly to the display of internal forces, the [Show results] button displays or hides the design
results. The [Show result values] button to the right controls the display of the result values.
Since the RFEM tables serve no function for the evaluation of the design results, you can hide
them.
To set the design cases in RFEM, select them in the list located in the RFEM menu bar.
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You can control the results display in the View navigator under the entry Results→ Members. By
default, it shows the stresses, ratios, and internal forces as Two-colored and the deformations
and eigenvectors as Lines.

Figure 6.7: Display navigator: Results → Deformation / Members

In case of a multi-colored display (Options Cross-Sections Colored or With/Without Diagram) the
color panel with the common control possibilities is available. These functions are described in
chapter 3.4.6 of the RFEM manual.

Figure 6.8: Normal stresses with display option Cross-Sections
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Figure 6.9: Eigenvector with display option Cross-Sections

You can export the graphics of the stresses, ratios, internal forces, and eigenvectors to the
printout report (see chapter 7.2, page 100).
The eigenvectors and deformations are relative to the centroid of the cross-section. The program does not determine local cross-section deformations.
You can compare the internal forces of RF-FE-LTB with the diagrams of the internal forces that
are available in RFEM for the respective load cases and combinations. Thus, you can check
whether the boundary conditions of the sets of members notionally singled out from the system have been considered correctly (nodal supports, loads, imperfections, etc.)

Figure 6.10: Moments My in RFEM (above) and RF-FE-LTB (below)

To return to the add-on module, click [RF-FE-LTB] in the panel.
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6.3

Result Diagrams

The result diagrams of a set of members can be evaluated graphically in the results diagram,
too.
To do this, select the member or set of members in the RF-FE-LTB results window by clicking in
the table row of the member. Then, open the Result Diagram on Member dialog box by clicking
the button on the left. It is located at the bottom of the table (see Figure 6.1, page 90).
In the RFEM graphic, you can access the result diagrams by selecting
Results → Result Diagrams for Selected Members
or click the according button in the RFEM toolbar.
A window opens, graphically showing the diagram of the results on the member or set of
members.

Figure 6.11: Dialog box Result Diagram on Member

In the navigator, you can select the stresses, ratios, deformations, internal forces, or eigenvectors that should be displayed in the results diagram. To switch between the design cases
of RF-FE-LTB, use the list in the toolbar.
The Result Diagram on Member dialog box is described in chapter 9.5 of the RFEM manual.
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6.4

Filter for Results

The RF-FE-LTB results windows allow you a selection by various criteria. In addition, you can
use the filter options (described in chapter 9.9 of the RFEM manual) in order to evaluate the
design results graphically.
In RF-FE-LTB, you can use the possibilities of the Visibilities (see RFEM manual, chapter 9.9.1) to
filter the sets of members and members for the evaluation.

Filtering Checks
You can also easily use the stresses and ratios as filter criteria in the RFEM work window, which
you can access by clicking [Graphics]. To do this, the panel must be shown. If it is not active,
you can switch it on by using the RFEM menu
View → Control Panel (Color, Scale, Factors, Filter)
or click the according button in the toolbar.
The panel is described in chapter 3.4.6 of the RFEM manual. To specify the filter settings for the
results, use the first panel tab (color scale). This tab is not available for the two-colored display.
Hence, you must set in the Display navigator the display option With/Without Diagram or CrossSections.

Figure 6.12: Filtering the utilization ratios with adjusted color scale

As the figure above shows, you can set the value scale of the panel in such a way that only utilization ratios greater than 30% are shown in the color interval between cyan and red.
To show all utilization distributions that are not covered by the value scale, select the Display
Hidden Result Diagram check box in the Display navigator (Results→ Members). These distributions are represented by dotted lines.
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Filtering members
In the Filter tab of the control panel, you can specify the numbers of selected members to filter
the results. This function is described in chapter 9.9.3 of the RFEM manual.

Figure 6.13: Member filter for utilization ratios of a frame

In contrast to the visibility function, the complete model is also shown. The figure above shows
the utilizations of a set of members in a frame. The remaining members are shown in the model
but without the utilization ratios.
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7.

Printout

7.1

Printout Report

For the data of the module RF-FE-LTB, a printout report is generated to which you can add
graphics and descriptions, just like in RFEM. The selection in the printout report controls which
data of the design module will finally appear in the printout.
The printout report is described in the RFEM manual. Chapter 10.1.3.4 Selecting Data of Add-on
Modules explains how to prepare the output data of add-on modules for the printout.
For complicated systems with many design cases, splitting the data into several printout reports contributes to a clear overview.

7.2

Graphic Printout

You can import every picture shown in the work window to the printout report or send it directly to the printer. Thus, you can prepare the utilizations shown on the RFEM model for the
printout.
Printing graphics is described in chapter 10.2 of the RFEM manual.

Analyses on the RFEM model
To print the currently displayed graphic of the stress ratios, use the menu
File → Print
or click the according button in the toolbar.

Figure 7.1: Button Print in RFEM toolbar

Result Diagrams
In the Result Diagram on Member dialog box, you can also add the graphic of stresses and
stress ratios to the report by clicking [Print]. Moreover, you can print it directly.

Figure 7.2: Button Print in the Result Diagram on Member

The following dialog box appears.
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Figure 7.3: Dialog box Graphic Printout, tab General

This dialog box is described in chapter 10.2 of the RFEM manual. There, you can also find information on the tabs Options and Color Scale.
To move the graphic to another place in the printout report, use the drag-and-drop function.
To adjust a graphic in the printout report subsequently, right-click the according entry in the
navigator of the report. The Properties command in the context menu reopens the Graphic
Printout dialog box where you can adjust the settings.

Figure 7.4: Dialog box Graphic Printout, tab Options
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8.

General Functions

This chapter describes useful menu functions and presents export options for the designs.

8.1

Design Cases

Design cases allow you to combine groups of structural components or sets of members with
certain design specifications (for example modified materials, partial safety factors, or optimization).
It is no problem to analyze a set of members in different design cases.
In RFEM, you can also set the design cases of RF-FE-LTB using the load case list in the toolbar.

Create new design case
To create a new design case, select from the RF-FE-LTB menu
File → New Case.
The following dialog box appears.

Figure 8.1: Dialog box New RF-FE-LTB Case

In this dialog box, you must enter a No. (one that is still free) for the new design case. The
Description facilitates the selection in the load case list.
After you click [OK], the 1.1 General Data window of RF-FE-LTB appears where you enter the
design data.

Rename design case
To change the name of the design case, select on the RF-FE-LTB menu
File → Rename Case.
The following dialog box appears.

Figure 8.2: Dialog box Rename RF-FE-LTB Case

Here, you can specify a new Description as well as a different No. for the design case.
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Copy design case
To copy the input data of the current design case, select on the RF-FE-LTB menu
File → Copy Case.
The following dialog box appears.

Figure 8.3: Dialog box Copy RF-FE-LTB Case

In this dialog box, you can specify the Number and, if necessary, a Description for the new case.

Delete design case
To delete a design case, select on the RF-FE-LTB menu
File → Delete Case.
The following dialog box appears.

Figure 8.4: Dialog box Delete Case

You can select the design case from the Available Cases list. To delete the case, click [OK].
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8.2

Units and Decimal Places

The units and decimal places are commonly managed for RFEM and for the add-on modules.
In RF-FE-LTB, you can open the dialog box for the adjustment of units by selecting on the menu
Settings → Units and Decimal Places.
The dialog box known from RFEM appears. In the Program / Module section, RF-FE-LTB is preset.

Figure 8.5: Dialog box Units and Decimal Places

For RF-FE-LTB, there are two tabs so that the specifications for the Input Data and the Results
are done separately.
You can save the settings as user-profile and reuse them in other models. These functions are
described in chapter 11.1.3 of the RFEM manual.
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8.3

Data Exchange

8.3.1

Material Export to RFEM

If you adjust the materials for the design in RF-FE-LTB, you can export the modified materials
to RFEM. Go to window 1.2 Materials and select on the menu
Edit → Export All Materials to RFEM.
Alternatively, you can open the context menu in window 1.2 to export the materials to RFEM.

Figure 8.6: Context menu of window 1.2 Materials

Before the material is exported, a query appears as to whether the results of RFEM should be
deleted.
If the changed materials have not been exported to RFEM yet, you can use the options shown
in Figure 8.6 to reload the original materials in RF-FE-LTB. Please notice that this option is available only in the 1.2 Materials window.

8.3.2

Export Cross-Section to RFEM

If you adjust the cross-sections for the check in RFEM, you can also export the changed crosssections to RFEM: Go to the 1.3 Cross-Sections window, and then select on the menu
Edit → Export All Cross-Sections to RFEM.
Alternatively, use the context menu in window 1.3 to export the cross-sections to RFEM.

Figure 8.7: Context menu of window 1.3 Cross-Sections

Before the material is exported, a query appears as to whether the results of RFEM should be
deleted.
If the changed cross-sections have not been exported to RFEM yet, you can reload the original
cross-section in RF-FE-LTB by using the options shown in Figure 8.7. Note that this possibility is
available only in the 1.3 Cross-Sections window.

8.3.3

Export Results

You can use the results of RF-FE-LTB in other programs, too.

Clipboard
To copy cells of the results windows to the Clipboard, press [Ctrl]+[C]. To paste them, for example in a word processor, press [Ctrl]+[V]. The headings of the table columns are not exported.
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Printout Report
The data from RF-FE-LTB can be printed to the printout report (see chapter 7.1, page 100).
You can export the data from the report by using the menu
File → Export in RTF.
This function is also described in chapter 10.1.11 of the RFEM manual.

Excel / OpenOffice
RF-FE-LTB allows for the direct data export to MS Excel, OpenOffice.org Calc, or the CSV format.
To start this function, select on the menu
File → Export Tables.
The following export dialog box appears.

Figure 8.8: Dialog box Export - MS Excel

Once the selection is complete, start the export by clicking [OK]. Excel or OpenOffice is started
automatically, that is, you do not have to open them first.

Figure 8.9: Exported results in Excel
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9.

Worked Examples

In this chapter, we present some examples from literature and compare them to the results in
RF-FE-LTB.
For these examples, there are usually no analytical solutions. The approaches used in the literature are either numerical or based on the RITZ or GALERKIN method with one or multi-elemental
approaches, which in turn represent approximate solutions describing the lateral-torsional
buckling by means of differential equations. Thus, it cannot be expected that the results from
RF-FE-LTB are completely identical to results in the literature.

9.1

Beam Under Concentrated Load

System
Q = 75 kN

l = 2.68 m
Figure 9.1: System and loading

Cross-section values and material:

IPE 200, steel S 235

The beam has pinned supports at both edges but there is no warping restraint. Thus, the following boundary conditions exist:
Left support:

u = v = w = ϕx = 0

Right support:

v = w = ϕx = 0

Two cases are analyzed:
First case:
Second case:

9.1.1

pure bending without rotational restraint
pure bending with rotational restraint

Bending Without Rotational Restraint

N = 0, cϑ = 0
The elastic critical moment for lateral-torsional buckling according to ROIK, CARL, LINDNER [3] is:

M cr ,y = ζ

r2 E Iz
2

L

Iy + 0.039 L2 J
Iz

For ζ = 1.35, we obtain after inserting the according values:

Mcr = 83.9 kNm

RF-FE-LTB gives the following load factors ν and critical moments Mcr,y :
Initial deformation
(L/400)

Direction of displacement

none
Eigenvectors
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v

ν

Mcr,y [kNm]

1.68

50.25*1.68 = 84.42

1.63

50.21*1.63 = 81.84
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The elastic critical moment for lateral-torsional buckling should always be calculated without
initial deformations, because it belongs to the critical load of the system. If we apply an initial
deformation, we obtain a smaller value of Mcr than in case of a calculation without consideration of the imperfection.
The value of Mcr,y = 84.42 kNm should be used in the calculation according to the equivalent
member method according to DIN 18800 Part 2: In window 1.4 of the add-on module RF-LTB,
you can define Mcr manually.

Figure 9.2: RF-LTB window 1.4 with manual possibility of defining Mcr

9.1.2

Bending with Rotational Restraint

N = 0, cϑ = 50 kNm/m
With the equation for the ideal torsional constant

Jid = J + c L

L2
π2 G

we obtain Mcr,y = 191.1 kNm.
Taking into account the rotational restraint, RF-FE-LTB determines the following load factors ν
and elastic critical moments Mcr,y :
Initial deformation
(L/400)

Direction of displacement

none
Eigenvectors
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v

ν

Mcr,y [kNm]

3.67

50.25*3.67 = 184.42

3.60

50.25*3.60 = 180.90
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9.2

Beam Under Uniform Loading

System
q = 34 kN/m

q

l = 6.00 m
Figure 9.3: System and loading

This example is taken from the SCHNEIDER Bautabellen (18th edition, page 8.46) [5].
Cross-section values and material:

IPE 400, steel S 235

The system has pinned supports at both end but no warping restraint. Thus, we have the
following boundary conditions:
Left support:
Right support:

u = v = w = ϕx = 0
v = w = ϕx = 0

The uniform load q acts on the upper flange of the beam.
As expected, RF-FE-LTB yields different stability loads with and without initial deformations.
These are summarized in the following table; a convergence study was carried out to determine
the precision of the calculation depending on the amount of elements. For the calculation including the initial deformation based on the eigenvectors, an initial bow imperfection of L/400
is applied.
νE

Elements

ν

4

1.31

153.0*1.31 = 200.4

1.27

0.91*34 = 30.94

8

1.28

153.0*1.28 = 195.8

1.24

0.89*34 = 30.26

16

1.27

153.0*1.27 = 194.3

1.23

0.89*34 = 30.26

32

1.26

153.0*1.26 = 192.8

1.23

0.89*34 = 30.26

64

1.26

153.0*1.26 = 192.8

1.23

0.89*34 = 30.26

Mcr,y [kNm]

qmax [kN/m]

In the table, ν denotes the load factor without considering the initial deformation and ν E denotes the load factor of the imperfect system based on the eigenvectors. From the results, we
can see that all types of calculation (with/without initial deformation and in case of stress limitation) reach a very good precision with 8 elements. The calculation with 32 elements represents the converging solution, as the doubling of the number of element results in no change.
In the SCHNEIDER Bautabellen [5], the value is given as Mcr,y = 169.2 kNm.
The limitation of the elastic stress to fy,k = 24 kN/cm2 results in RF-FE-LTB in the maximum resisting load of qmax = 0.89 · 34 = 30.26 kN/m. This load is less than the value given in [5]. The
reason for this is that the plastic reserve of the cross-section is not taken into account in the
determination of the elastic limit load FG. With the program RF-LTB, however, you can consider
this.

Program RF-FE-LTB © 2013 Dlubal Software GmbH

109

9 Worked Examples

9.3

Cantilevered Beam with Warping Restraint

In this example according to SCHNEIDER Bautabellen (18th edition, page 8.20) [5], the warping
torsional moment My is to be calculated.

System
MT = 6.5 kNm
l = 2.50 m
Figure 9.4: System and loading

Cross-section properties and material:

HEB 240, steel S 235

The cross-section is restrained to warping at the location of fixity. Thus, on the left end of the
beam, the following boundary conditions exist:
u = v = w = ϕx = ϕy = ϕz = y = 0
The calculation according to [5] gives the warping torsional moment My = -70,494 kNcm2.
The analysis with RF-FE-LTB gives the value My = -70,400 kNcm2.
The according Rotation ϑ is given in [5] as 6.3°.
RF-FE-LTB determines the value ϕx = 0.1214  180/r = 6.96°.
The comparison of the stresses in [5] and RF-FE-LTB gives the following result:

110

Stress

SCHNEIDER [5] [kN/cm2]

RF-FE-LTB [kN/cm2]

σy

±19.4

±19.35

τMx,p

8.5

8.73

τMx,s

1.07

1.07
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9.4

Cantilevered Beam Under Uniform Load

In this example according to PETERSEN [2], page 732, the lateral-torsional load and the according
critical moment for lateral-torsional buckling are calculated.

System
q=1

kN
m

l = 3.00 m

b

a

Load application in cross-section

d

c

150 mm
Figure 9.5: System and loading

Cross-section properties and material:

9.4.1

IPE 200, steel S 235

Crane Runway Beam with Free End

The cross-section is restrained to warping at the point of fixity. Thus, on the left end of the
beam, the following boundary conditions exist:
u = v = w = ϕx = ϕy = ϕz = y = 0
ν4

νE4

ν8

νE8

ν64

νE64

νPETERSEN

Top (a)

20.27

20.19

20.52

20.44

20.56

20.56

19.06

Centroid (b)

36.81

36.78

37.78

37.62

38.06

36.06

38.13

Below (c)

52.75

52.75

54.02

53.75

54.25

54.06

57.19

Suspended (d)

66.56

66.25

67.75

67.25

68.25

67.62

76.25

Load effect

The values ν mean: νn is the result from RF-FE-LTB without imperfections for n elements; νEn is
the result with initial deformation based on the scaled eigenvectors. The scaling is carried out
with the value 0.75 (displacement perpendicular to the drawing plane at the end of the cantilever).
Here, the analysis with eight elements also comes close to the converged solution.
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9.4.2

Cantilever End with Lateral Restraint

The cross-section is warping-restrained and restrained by a bracing on the right side. Furthermore, torsion is restrained at the end of the cantilever. Thus, the following boundary conditions
exist:
u = v = w = ϕx = ϕy = ϕz = y = 0
v = ϕx = 0

Left support:
Right support:

νRF-FE-LTB

νPETERSEN

Top (a)

68.75

67.10

Centroid (b)

90.56

91.51

Below (c)

114.50

115.9

Suspended (d)

146.20

149.5

Load effect

In RF-FE-LTB, eight elements give already a very good approximation for the values for the
load factor ν that in PETERSEN [2] result from nomograms for flexural-torsional buckling.

9.5

Beam Under Uniform Loading

For the following example according to PETERSEN [2], page 731, the critical load factor ν is calculated.

System
q

ν·q
q = 1 kN/m
l = 15.00 m
Figure 9.6: System and loading

Cross-section values and material:

HEB 800, steel S 235

The system has fork supports at both ends but no warping restraint. Hence, we have the
following boundary conditions:
Left support:

u = v = w = ϕx = 0

Right support:

v = w = ϕx = 0

The effect of the load q is analyzed for the top flange, the centroid, and the bottom flange.
RF-FE-LTB gives the following load factors ν or νE for an initial deformation of L/400.
ν

νE

νPETERSEN

Top flange

37.38

36.31

39.50

Centroid

46.38

44.88

48.61

Bottom flange

57.53

55.56

57.73

Load effect
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9.6

Continuous Beam Under Two Nodal Loads

In LINDNER [6] and DICKEL et al. [4], we can find calculations for the following two-span beam.
The two concentrated loads of F = 37.5 kN act in the span center in the centroid of the crosssection, respectively.

System
F

F

l=5m

l=5m

Figure 9.7: System and loading

Cross-section properties and material:

IPE 200, steel S 235

All supports of the beam are pinned supports. Thus, the following boundary conditions exist:
Left support:
u = v = w = ϕx = 0
Middle support: v = w = ϕx = 0
Right support:
v = w = ϕx = 0
The calculation is carried out with eight elements. The following values result for the elastic
critical moment for lateral-torsional buckling Mcr,y in [kNm] over the middle support.
Mcr,y LINDNER

Mcr,y DICKEL

Mcr,y

Mcr,y E

51.24

51.06

1.46*35.16 = 51.33

1.38*35.14 = 48.85

For the determination of Mcr,y E, an initial deformation of L/400 was applied.
The results of RF-FE-LTB correspond very well to those of [4] and [6].

9.7

Continuous Beam Under Uniform Loads

In DICKEL et al. [4], the elastic critical moments for lateral-torsional buckling of a two-span beam
are determined. The uniform load of the magnitude q = 10 kN/m acts on the top flange at a
distance of 14.5 cm from the centroid of the cross-section.

System
q = 10 kN/m

5m

q

10 m

Figure 9.8: System and loading

Cross-section values and material:

HEA 300, steel S 235

All supports of the beam are pinned supports. Thus, the following boundary conditions exist:
Left support:

u = v = w = ϕx = 0

Middle support: v = w = ϕx = 0
Right support:
v = w = ϕx = 0
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For the calculation in RF-FE-LTB, we specify an FE length of 50 cm. At the middle support, we
obtain the following values for the elastic critical lateral-torsional moment Mcr,y and the corresponding uniform load qcr,z.
DICKEL et al. [4]

RF-FE-LTB

PETERSEN [2]

ROIK et al. [3]

qcr,z [kN/m]

42.84

42.85

35.86

37.08

Mcr,y [kNm]

401.6

401.7

336.2

347.6

The results of RF-FE-LTB correspond very well to those of [4].
In further analyses, the maximum equivalent stresses for various values of uniform loads are
calculated on the predeformed system. RF-FE-LTB determines the maximum uniformly distributed load for which the stress σeqv = 24 kN/cm2 is observed.
q [kN/m]

max σeqv [kN/cm2]

10

8.75

20

18.76

24.3

24.0

An analytical equivalent calculation with the expressions given in [10] yields for the critical
span moment (ry = zM = 0):
M cr ,y = ζ

r 2 EI z 
2
2

 0.25 z p + c + 0.5 z p  = 28965 kNcm = 289.65 kNm
2


L

where ζ = 1.08 (see below) and zp = -14.5 cm and

c2 =

Iω L2 GJ 1,200 ,000 1000 2 ⋅ 8100 ⋅ 85.2
+
=
+ 2
= 717.9 cm2
6310
I z π 2 EI z
π ⋅ 21,000 ⋅ 6310

The value of ζ according to [3] represents the correction factor. The solution Mcr,y of a member
with fork supports at both ends and subjected to equal end moments is to be multiplied with
this correction factor.
It follows according to [3]:
0.375 q L21 = 0.09375 q L22

Mo
L1

Mo = q

0.5 L 2

L2

L1 = 5 m
L 2 = 10 m

L22 0.09375 2
−
q L2 = 0.078125 q L22
8
2

Mo was used in [3] to calculate νcr, that is, Mcr; thus, the elastic critical moment for lateraltorsional buckling given in [3] is relative to the center of span 2!
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χ=

E Iω
L2 GJ

=

21,000 ⋅ 1,200 ⋅ 10 3

(1,000 )2 ⋅ 8,100 ⋅ 85.2

= 0.037

Table 5.23 [3]

q L22
= ψ Msup port = ψ ⋅ (− 0.09375)q ⋅ L22
8
⇒ ψ = 0.09375 ⋅ 8 = 0.75 ⇒ ζ ≅ 1.08
M=−

Thus, the ideal column moment as the maximum moment calculated by RF-FE-LTB as well as
DICKEL [4] is:

M cr ,y span = 0.078125 qki ⋅ 10 2 = 289.65
⇒ q cr = 37.08 kN / m

M cr ,sup port = 0.09375 ⋅ 37.08 ⋅ 10 2 = 347.58 kNm
According to Petersen [2], Table 7.23, we obtain for the end span of a continuous beam with a
degree of restraint of 0.09375/0.125 . 100 = 75 % the following ideal values:
2

 zp  E Iz
= 0.04
o= 2
= 0.0365, χ = + 
L GJ
 L  GJ
γ
kN
E I z GJ = 35.86
⇒ γ cr ≅ 37.5 ⇒ q cr = cr
3
m
L
E Iω

⇒ M cr (sup port ) = 0.09375 ⋅ 35.86 ⋅ 10 2 = 336.2 kNm

The ideal values determined according to [3] or [4] are smaller than the values determined
here, since the restraining effects due to warping restraint of the first span are not considered
in the analytical formulas.

9.8

Three-Span Beam with Uniform Loadings

In PETERSEN [1], page 405 and DICKEL et al. [4], the elastic critical moments for lateral-torsional
buckling of a continuous beam are determined.

1st case: system with uniform loads
The line load of the magnitude q = 30.5 kN/m is constant over the entire beam. It acts on the
top flange at a distance of 18 cm from the centroid of the cross-section.

q = 30.5 kN/m

6m

6m

q

6m

Figure 9.9: System and loading

Cross-section properties and material:

IPE 360, steel S 235

All supports of the beam are pinned supports. Thus, the following boundary conditions exist:
Left support:
u = v = w = ϕx = 0
Middle supports: v = w = ϕx = 0
Right support:
v = w = ϕx = 0
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The analysis in RF-FE-LTB is run with 18 and with 72 elements. At the inner supports, we obtain
the following values for the elastic critical moment for lateral-torsional buckling Mcr,y and the
according uniformly distributed load qcr,z :
PETERSEN [1]

DICKEL [4]

RF-FE-LTB
18 elements

RF-FE-LTB
72 elements

qcr,z [kN/m]

45.32

48.8

1.66*30.5 = 50.6

1.63*30.5 = 49.7

Mcr,y [kNm]

163.2

175.7

1.66*109.8 = 182.3

1.63*109.8 = 179.0

The results from RF-FE-LTB correspond very well to those of [1] and [4].
For an initial deformation of L/400 = 600/400 = 1.5 cm, we obtain for this line load the
maximum equivalent stress σeqv = 16.9 kN/cm2.
For a stress limitation to σeqv = 24 kN/cm2, we obtain the maximum resistant load
qmax = 36.2 kN/m.

2nd case: system with different loads
In the second case, the center span is not loaded by q = 30.5 kN/m but by a reduced line load
of g = 5.5 kN/m.

g = 5.5 kN/m

6m

6m

q = 30.5 kN/m

q

6m

Figure 9.10: System and loading

The elastic critical moments for lateral-torsional buckling under this loading are governing not
for columns but for the outer spans.

Mcr,y [kNm]

PETERSEN [1]

DICKEL et al. [4]

RF-FE-LTB

137.8

162.24

1.57 * 104.8 = 164.5

The result in RF-FE-LTB corresponds well to the value in [4]. The elastic critical moment for lateral-torsional buckling given in [1] is on the safe side, because there the warping restraints
over the supports and the restraint effects due to warping restraint of the less loaded adjacent
span are neglected.
For an initial deformation of L/400 = 600/400 = 1.5 cm, we obtain for this line load the maximum
equivalent stress σeqv = 21.2 kN/cm2.
In case of a stress limitation to σeqv = 24 kN/cm2, the maximum resistant loads are
qmax = 1.06  30.5 = 32.3 kN/m (outer spans) and qmax = 1.06  5.5 = 5.8 kN/m (inner spans).
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9.9

Beam on Foundation with Axial Force

A beam with pinned supports is restrained at the top flange and in addition has an elastic torsional restraint. The analytical solution can be taken from the publication of WITTEMANN [12],
where the elastic lateral-torsional buckling load of a compressive member with elastic torsional restraint and translational restraint is determined. For this, we consider the following system.

cϑ
F
y

l = 29 m

z
Figure 9.11: System and loading

Cross-section values and material:

IPE 400, steel S 235

The beam has pinned supports on both ends but no warping restraint. Thus, the following
boundary conditions exist:
Left support:

u = v = w = ϕx = 0

Right support:

v = w = ϕx = 0

At the top flange, the beam is laterally restrained by a stiffening. In RF-FE-LTB, this lateral
restraint is modeled by a very stiff spring. Furthermore, there is a rotational restraint of
cϑ = 9.936 kNm/m.
At first, the calculation in RF-FE-LTB (without initial deformation) gives the value
Ncr ,y = 100 ⋅ 5.7 = 570.0 kN .

This result, however, represents the buckling load about the main axis:
Ncr ,y =

21,000 ⋅ 23,130 ⋅ r 2
2,900 2

= 570.0 kN

By means of a vertical support in the midspan, that is, w*(L/2) = 0, a significantly lower critical
load is determined, since RF-FE-LTB now uses the higher eigenvectors:
Ncr ,ϑ = 100 ⋅ 2.27 = 227 kN

Thus, we can see how the modeling of members on elastic foundation with translational restraint influences the elastic critical load for lateral-torsional buckling, especially for large span
lengths.
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9.10

Roof Beam in Office Building

The roof beams of an office building are arranged at a distance of 5.0 m. They are stiffened by a
connecting Thyssen T135.1 - 0.75 trapezoidal sheet and a connected cross-bracing.
The shear panel length of the trapezoidal sheet is LS = 20 m. The cross-bracing consists of only
one panel with crossed diagonals and two posts. Hence, the inclination angle of the diagonal
is α = arctan (5.0/7.75) = 32.8°.

System
qd

7.75 m
Figure 9.12: System and loading

Cross-section properties and material:

IPE 270, steel S 235

Because of the shear connections by end plates to the laterally restrained columns (by means
of vertical bracing), we can assume pinned supports at both ends of the beam. Thus, the following support conditions exist:
Left support:
Right support:

u = v = w = ϕx = 0
v = w = ϕx = 0

AP
α

IPE 270

AD

T135

= 7.75 m
l

LS = 20 m
Figure 9.13: Beam in roof plane

The trapezoidal sheet provides a lateral elastic restraint and a rotational elastic spring to the
roof beam at the height of the top flange.

prov.

qd
y

y

S,
prov.

zP = -13.5
(Load application on
top flange)

ϑ

z
Figure 9.14: Support of the beam and effect of the load
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The design load from self-weight and snow is:
qd = 1.35 g + 1.5 p = 11.79 kN/m

Determination of the horizontal spring
The calculation of the spring constants for the shear stiffness from roof bracing is described in
chapter 2.5.2 on page 27 as well as in [2] and [10].
Continuous lateral translational spring:
c y = prov S a

r2
L2

kN

= 1,158

m2

Since the trapezoidal sheeting is fixed only in each second groove, ST may be applied only with
1/5 of the shear stiffness.

1
prov Sa = S T + SR
5

Bracing
SR = m ⋅

a
⋅ S V = 3,347 kN
Ls

where

m=1

one bracing

a = 5.0 m
LS = 20.0 m

SV =

a2 ⋅ b ⋅ E
3

 a2 + b 2 


3

 +a
AD
AP

= 13,389 kN

a = 500 cm
b = 750 cm
E = 21,000 kN/cm2
AD = 2.63 cm2

area of diagonal

AP = 8.00 cm

area of post

2

Trapezoidal sheeting
ST =

a
⋅ GS = 16 ,250 kN
100
10 4
= 3,252 kN / m
where GS =
k
k1 + 100 ⋅ 2
Ls

ideal shear modulus

k1 = 0.275 m/kN
k2 = 56 m2/kN
LS = 20 m
The spring cy is laterally applied at the top flange.
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Determination of the rotational spring
The calculation of the spring constants from the connecting trapezoidal sheeting is described
in chapter 2.5.1 on page 25 as well as in [2], [8] and [10].

1
1
1
1
1
1
1
=
+
+
=
+
+
= 0.20999
prov c ϑ,k c ϑM,k c ϑA ,k c ϑP ,k 499 5.23 59.6
⇒ prov c ϑ,k = 4.76

kNcm
cm

Restraining structural component
The rotational restraint from the bending stiffness Ia = 297 cm4/m of the trapezoidal sheeting
(k = 4 for continuous beams with three spans) is obtained as follows:

cϑM,k =

EIa
21,000 ⋅ 2.97
kNcm
⋅k =
⋅ 4 = 499
a
500
cm

Deformation of cross-section
The rotational restraint from the section deformation of the supported beam is obtained as
follows:

cϑP ,k =

21,000
1
E
1
kNcm
⋅
=
⋅
= 59.6
cm
4 ⋅ (1− µ2 ) hm + 0.5 ⋅ b1 4 ⋅ (1− 0.32 ) 27 − 1.02 + 0.5 ⋅ 13.5
0.663
1.023
s3
t13

where

b1

Flange width of the compression flange

Connection deformation
The rotational restraint from the deformation of the connection is determined for
1.25 ≤ b1 / 10 ≤ 2.0 as follows:

c ϑA ,k = cϑ,Ak ⋅1.25 ⋅
where

b1
13.5
kNcm
= 3.1⋅1.25 ⋅
= 5.23
10
10
cm

cϑA ,k

Characteristic values for connecting stiffness acc. to Table 7 [8]

Selection of the eigenvector
The elastically supported member is calculated on the imperfect system according to secondorder analysis. Here, an initial deformation in direction y is applied with the following camber
rise of the parabola (see chapter 2.6.2, page 37):

2 L
L
v 0 = 0.5 ⋅ ⋅
=
= 1.03 cm
3 250 750
This value is obtained according to Table 3 [8] for the buckling curve b and the reductions
according to element (201) and (202) [8].
In this example, the eigenvectors are compared in order to find the governing eigenvalue
(see the following figure).
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Figure 9.15: First and second eigenvector

The graphic of eigenvectors makes it clear that the first eigenvalue is governing.

Determination of the magnitudes of imperfection
Different values s are relevant for the two eigenvectors.
Eigenvector No. 1:

2 L
775
=
= 1.03 cm
v 0 = 0.5 ⋅ ⋅
3 250 750
Eigenvector No. 2:

2 L
0.5 ⋅ 775
v 0 = 0.5 ⋅ ⋅
=
= 0.517 cm
3 250
750
For the second eigenvector, only the length of one half-wave is taken as reference size.
The following table shows the equivalent stresses that result from the different eigenvectors
and magnitudes of imperfection.

σeqv [kN/cm2]

Eigenvector No. 1

Eigenvector No. 2

21.18

20.71
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9.11

Beam with Eccentric Uniform Load

We want to analyze a steel beam subjected to biaxial bending. The loads act 5 cm above the
top flange.
In PETERSEN [2], Table 7.29, the normal stress σx in the shear point (1) is determined analytically.

System
qyd , qzd

8.00 m
qzd
(1)
y

qyd

pinned supports on both ends
qzd = 68 kN/m
qyd = 6.8 kN/m
zP = -35 cm
yP = 0

5 cm
30 cm

S,M

z
Figure 9.16: System and loading

Cross-section properties and material:

HEB 600, steel S 235

As imperfection, we take an initial deformation in the direction of the member axis y with the
following magnitude of imperfection (see Table 3 in [8]):

2 L
v 0 = 0.5 ⋅ ⋅
= 1.07 cm
3 250
The calculation in RF-FE-LTB uses 16 elements.
We obtain the following stresses and rotational movements:
PETERSEN [2]

RF-FE-LTB

22.55

24.15

3.645 . 10-2

4.360 . 10-2

σx in (1) [kN/cm2]
Rotation ϕx in L/2 [rad]
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